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Resumen

El tema principal de este proyecto es la realizacion de una simulacién de un
proceso de fundicion con molde de arena mediante QuikCast. Con este software se
obtendran los resultados para los procesos de llenado y solidificacion, asi como la
posibilidad de analizar la pieza una vez completada la simulacion de la simulacion.

Las herramientas que se han utilizado para la realizacion de este proyecto son el
software de dibujo Solid Edges, para realizar los disefios en 3D y el software de
simulacion QuikCast, que permite la simulacion del proceso de llenado y la
solidificacion de la pieza.

Para realizar la simulacién se ha necesitado aprender el funcionamiento del
programa para poder realizar una correcta simulacién. Ademas se realiza un manual del
profesor y otro para alumno.

Estos manuales estas hechos para que se realice la simulacién de una pieza
durante la sesion précticas.
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Introduccion

Estructura del proyecto

A continuacion se muestra un resumen del proyecto:

e Capitulo 1: Fundicion por gravedad. Este apartado muestra las etapas de la
fundicion, sus ventajas e inconvenientes, sus aplicaciones y los defectos mas
comunes.

e Capitulo 2: Material del molde. Se muestra las caracteristicas del molde y sus
propiedades.

e Capitulo 3: Material pieza. Este apartado muestra las propiedades y las
caracteristicas de la aleacion.

e Capitulo 4: Manual usuario. En este apartado se muestra la forma de cémo
manejar el programa: como moverse por el area de trabajo, la forma de realizar
una simulacion de una pieza en un proceso de fundicién por gravedad con molde
desechable de arena.

e Capitulo 5: Manual profesor. Se muestra los pasos que hay que realizar para
simular la pieza que se realiza en las précticas con las explicaciones necesarias
para realizar la simulacion de la pieza y los errores que pueden cometer los
alumnos y los fallos que se producen en el programa.

e Capitulo 6: Guion alumno. En este apartado se indica al alumno como realizar
la simulacion de la pieza hecha en précticas.

e Capitulo 7: Evolucion del molde. Se muestra los diferentes tipos de moldes
para analizar los diferentes resultados.
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Capitulo 1: Fundicion por gravedad en molde de arena

1.1 Generalidades

El proceso de fundicion consiste basicamente en la introduccién de un metal en
estado liquido en el interior de un molde y la posterior solidificacion del metal
reproduciendo la geometria de la superficie interna del molde, de tal manera que
obtengamos la pieza deseada con una baja porosidad, buen acabado y una exactitud
dimensional adecuada.

La arena es el material mas empleado para en los moldes desechables ya que es
el material mas econdmico y posee una elevada resistencia a las altas temperaturas. Esto
permite fundir metales con temperaturas de fusion muy altas, como el acero o el titanio.

Las principales etapas que se realizan en este proceso son:

-Preparacion del molde: se fabrica el molde de arena utilizando el modelo con la
forma de la pieza, teniendo en cuenta que hay que sobredimensionar el modelo para
evitar las contracciones del metal.

-Preparacion de los machos: se colocan los machos en el interior para la conformacién
del interior de la pieza.

-Realizacién de la colada: consiste en llenar el molde, se puede realizar por diferentes
formas por ejemplos gravedad, lateral o por inyeccion.

-Enfriamiento de la pieza: se trata en solidificar el material vertido en el molde a una
velocidad adecuada para evitar posibles defectos como grietas y sopladuras.

-Extraccién de la pieza: una vez solidificada y enfriada la pieza, se procede a la
apertura del molde. Para mejorar la extraccion de las piezas se recubren previamente
con un agente desmoldeante.
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1.2 Elementos del molde

El molde casi siempre se disefia en dos mitades, disefidndose con una linea
divisoria ya sea en posicién vertical u horizontal, que se denomina linea de particion.

Caja de moldeo
superior

Macho _ame
— >

. ! Modelo superior @77
i i i et
i Mazarota— : - .-
! ! Bebedero .~

FPieza desmoldeada

Proceso de
desbarbado

Arena de m!oldeo

compm;lada = Maodelo inferior

Caja de moldeo
inferior
Pieza acabada

Figura 1.1
Las partes que componen el molde son:

e Bebedero: es el orificio por el cual se alimenta el molde con el metal fundido.

e Mazarota: son depdsitos de metal fundido que sirven para compensar la
contraccion del metal de la pieza en el momento de la solidificacion, para evitar
que se creen cavidades. Las mazarotas tienen forma troncoconica y pueden ser:

o Abiertas: tienen un orificio en que da al exterior y permite saber si el
molde esté Ileno si el metal fundido rebosa por la mazarota.

o Cerradas: estdn dentro del molde y se usan cuando alguna parte del
interior del molde se va a quedar sin suministro de metal.

e Canal de distribucién: son los canales por donde se realiza el llenado del
molde. Los canales de distribucién se pueden dividir en:

o Canal de colada: son los canales que comunican directamente con el
bebedero.
o Ataques: son los canales que comunican el canal de colada con la pieza.

e Machos: son insertos introducidos en el molde y permiten realizar el interior de
la piezas.

e Caja de moldeo: es la caja, rectangular o circular, en ella se colocan todos
elementos citados anteriormente. Puede ser:

o Superior: en ella se suele colocar los respiraderos, las mazarotas, los
rebosaderos y el canal de llenado.

o Inferior: hace las funciones de base y se realizan en ella parte de los
canales de llenado.

e Modelo: es una pieza que representa la geometria exterior de la pieza que se
quiere realizar.
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1.3 Etapas del moldeo

Se describe las diferentes etapas que se realizan en el proceso de moldeo:

. ) ,—’ Desmoldado
Disefio y Fundir

fabricacion de metal Moldeo l
elementos del 2 Limpieza
moldeo Preparar elementos superficie
de molde v
Inspeccion

v
Tratamiento
térmico

v

Mecanizado

A 4

A 4

A 4

Figura 1.2

La primera fase consiste en disefiar el molde y los elementos necesarios para el
moldeo a partir de la pieza. A continuacion se pasa a calcular las dimensiones de las
cavidades, mazarotas, sistemas de alimentacion... para la correcta fabricacion de la
pieza.

Cuando ya se ha disefiado el molde se funde el material y se vierte en el interior
del molde. Una vez que se ha solidificado se procede al desmoldado y a la limpieza de
la superficie eliminando las partes sobrantes de la pieza.

A continuacion se realiza una inspeccion visual para comprobar que la pieza esta
en perfecto estado. En funcion del uso de la pieza se puede realizar algin tratamiento
térmico o el mecanizado para mejorar sus propiedades.
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1.4 Aplicaciones

Los productos obtenido mediante este método se resume en el siguiente cuadro.
ALEACION APLICACIONES

ALUMNIO Enseres domeésticos, componentes automotrices,
carcasas de motores eléctricos.

Formas complejas de pared delgada y piezas que
requieren resistencia a temperaturas elevadas.

LATON Articulos de fontaneria, herreria.

MAGNESIO Herramientas eléctricas, piezas automotrices y
articulos deportivos

ZINC Piezas automotrices, equipos de oficina, utensilios
domésticos, herrajes para la construccion y
juguetes.

1.5 Ventajas e inconvenientes

Las ventajas de la fundicién en arena son:

<\

Es un proceso mas barato que el resto.

Resistencia a altas temperaturas.

Posibilidad de obtencion de piezas con espesores pequefios.
Posibilidad de utilizacion en gran cantidad de metales y aleaciones.
Acabado uniforme vy liso.

No requiere de tolerancias especiales.

Aproximadamente un 90% del material del molde es reciclable.

Se trata de un proceso flexible con costos de materiales bajos.
Piezas sin tensiones residuales.

AN NI N N N W

Los inconvenientes son:

b 4

No se trata de un proceso recomendado para piezas de gran tamafio.

Las tolerancias que se obtienen suelen ser bastante grandes.

% No es el proceso mas adecuado para la realizacion de piezas de geometria
compleja.

% Los acabados superficiales que se obtienen no son los mejores.

% Piezas con resistencia mecanica reducida.

b
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1.6 Defectos

En las fundiciones se pueden generar varios defectos dependiendo de factores
como los materiales, disefio de las piezas y técnicas de fabricacion. Algunos de los
defectos solo afectan a la apariencia de la pieza pero otros causan efectos adversos en la
estructura de la pieza. Los defectos son:

e Proyecciones metalicas: formadas por aletas, rebabas o proyecciones masivas
como ondulaciones y superficies asperas.

e Cavidades: formadas por cavidades redondeadas, incluyendo sopladuras,
porosidades y cavidades de contraccion.

e Discontinuidades: son grietas, en frio o caliente, y puntos frios. Si al metal en
solidificacion se le restringe en su libre contraccion, puede ocurrir el
agrietamiento y el desgarramiento.

e Superficies defectuosa: son pliegues, capas de arena adheridas y cascarilla de
oxido.

e Fundicion incompleta: son las faltas de llenado debido a una solidificacion
prematura, volumen insuficiente de metal y fugas.

e Dimensiones o formas incorrectas: debido a factores como una inadecuada
tolerancia de contraccion, un error en el montaje del modelo, una contraccién
irregular o el modelo esta deformado.

¢ Inclusiones: se forman durante la fusion, solidificacion y moldeo. Por lo general,
de naturaleza no metélica, se consideran como perjudiciales porque actian como
elevadores de esfuerzo y reducen la resistencia de la fusion.

Los principales ensayos para reconocer los defectos eventuales:

e Asimple vista: deformaciones, rugosidades, rechupes y heterogeneidades.

e Trazado: dimensiones de las piezas.

e Examen magnético o liquidos penetrantes: revela grietas y discontinuidades
en las piezas fundidas.

e Rayos X, ultrasonidos: se visualizan defectos internos, sin destruirlas.
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Capitulo 2: Material del molde

2.1 Caracteristicas de las arenas de moldeo

Las arenas silito-aluminosas procedentes de la descomposicion de rocas
igneas son las mas utilizadas y se llaman arenas de moldeo. Sus granos estan entre 0.05
y 2 mm 'y, fundamentalmente, estan formadas por cuarzo y arcilla, de los cuales se
exigen unos porcentajes, aungque puede que tengan otros elementos secundarios. El
cuarzo (Si02) es el principal componente y, por tanto, su proporcion la mayor (80-
90%). La arcilla es un silicato de alimina hidratado y su porcentaje suele estar en torno
al 10%. Se encuentra rodeando a los granos de cuarzo, es decir, actla de aglutinante.
El porcentaje de humedad de las arenas esta en torno al 10%. Esa agua Se encuentra,
por un lado, formando parte de la propia constitucion de la arcilla y, por otro, como
agua libre formando parte de una humedad que puede tener o que podemos provocar.
Las arenas de molde naturales tienen entre un 5 y un 7% de humedad.

2.2 Propiedades

Las propiedades fundamentales que tienen las arenas de moldeo son las
siguientes:

e Plasticidad: es la capacidad para reproducir los detalles de los modelos.
Depende de dos factores:

o Deformabilidad: es la actitud para cambiar de forma. Depende de los
porcentajes de arcilla, de la humedad e, incluso, de la forma del grano.
o Fluencia: es la capacidad de transmitir la presion a través de ella.

e Permeabilidad: es la facilidad para dejarse atravesar por el aire y los gases que
se desprenden al realizar la colada. Depende del tamafio y forma de los granos,
del contenido de arcilla, de la presion y del porcentaje de humedad.

e Refractabilidad: es la capacidad para soportar temperaturas elevadas. Depende
del tipo de arcilla

e Cohesion: capacidad de permanecer los granos unidos entre si. Depende del
porcentaje de arcilla.

¢ Reutilizacidn: tiene un alto grado de reciclaje (alrededor del 90%).
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Otra propiedad importante es el tamafo y distribucion de los granos ya que de
estos dos factores va a depender la calidad superficial de la pieza. El tamafio puede
variar entre 0.05 mm a 2 mm. Se clasifican de la siguiente manera:

Arena Indice AFS (i) |Tamano de granos (1mm)
Muy gruesa |18 1-2
Gruesa 18-35 0.5-1
Media 35-60 0.25-0.5
Fina 60- 150 0.10-0.25
Muy fina 150 0.05-0.10
Figura 2.1

2.3 Clasificacion de las arenas de moldeo

Se pueden tener distintas clasificaciones:

e Por su origen:
o Naturales o tierras de moldeo
o Sintéticas

e Por la humedad que tengan:

o Verdes o magras: se emplean para obtener piezas pequefias. El
contenido en arcilla es bajo y la humedad de estas permanece
constante.

o Secas 0 grasas: se han obtenido a base de un secado controlado para
mejorar la permeabilidad.

e Por su aplicacién en el moldeo:
o De revestimiento o contacto: en contacto con la pieza.
o Derelleno
e Segun su utilizacion:
o Paramolde
o Para macho

Existen otras clases de arenas que suelen tener aplicaciones muy
especificas como pueden ser:

e Arenas incrustadas: han estado en contacto con el metal y estan deterioradas

e Adobadas: tienen elementos adicionales para cohesionar

e De carbonato 0 negras: se les adiciona un pequefio porcentaje (2-3%) de
carbon.

e Al cemento: se les aporta cemento en un porcentaje variable y agua. Se
utilizan para obtener piezas muy grandes y exigentes, corro pueden ser las
hélices de los barcos.

e Barros: son aquellas con un porcentaje de arcilla muy elevado (hasta un 20%)
y otros elementos como cal y oxidos de hierro. Se utilizan para moldear
aceros.
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2.4 Arena Verde

El material elegido para el molde se denomina arena verde. El término “verde”
es porque el molde contiene humedad en el momento del llenado por lo que no se
necesita realizar un secado previo al molde. El color natural va desde el blanco hasta el
canela claro, pero con el uso se va ennegreciendo. La arena verde esta formada por una
mezcla de arena, arcilla y agua. El porcentaje de materiales en este tipo de arena es el
siguiente:

- 90% arena silica (SiO2)
- 7% arcilla
-3% agua

La arcilla actia como aglutinante, que permite mantener compacta la arena y que se
desmorone con facilidad al extraer la pieza.
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Capitulo 3: Material pieza

El material escogido para la simulacion del proceso es la aleacién de aluminio

AlSi7Mg.

El aluminio elegido presenta la siguiente composicién quimica:

Si Mg Mn Zn Cu Sn Al
7.00% 0.30% 0.05% 0.02% 0.01% 0.01% Resto
Tabla 3.1

Las principales caracteristicas del aluminio AlISi7Mg son:

Temperatura de fusion 613.00°C
Temperatura de 548.00°C
solidificacion
Temperatura eutéctica 570.00°C
Contraccidn 3.00%
Calor latente 431000.00 J/Kg

Tabla 3.2 Principales caracteristicas

Temperatura (°C)

Fraccién solida

548 1

551 0.99
560 0.95
566 0.77
570 0.49
577 0.44
582 0.41
593 0.32
601 0.25
610 0.14
612 0.09
613 0.00

Tabla 3.3 Fraccion Solida en funcién de la temperatura
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Temperatura (°C)

Densidad (Kg/m®)

20 2675
100 2661
400 2599
500 2576
548 2565
560 2560
566 2554
570 2522
589 2511
601 2502
613 2481
750 2445

Tabla 3.4 Densidad en funcion de la temperatura

Temperatura (°C)

Calor especifico

(UI(Kg™K)
20 919
100 940
200 965
300 991
400 1020
500 1045
548 1045
613 1045
750 1045

Tabla 3.5 Calor especifico en funcién de la temperatura
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Temperatura (°C) CondL(J\c/;t/i/\zin(ji(Ij(';?rmica

20 154
100 156
200 163
300 170
400 172
500 174
548 175
570 125
613 80
750 80

Tabla 3.6 Conductividad térmica en funcion de la temperatura

La aleacién AlSi7Mg destaca por su buena colabilidad en la fundicion, tiene
excelentes cualidades de soldabilidad y muestra una alta dureza dentro de los aluminios.
Gracias a su buena dureza y soldabilidad combinado con una alta resistencia es muy
usado para aplicaciones criticas. Esta aleacion también permite ser tratada térmicamente
lo que supone poder variar sus cualidades segun el interés. También es muy usado para
la decoracion y adorno, ya que ofrece mucha facilidad para el pulido.
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Capitulo 4: Manual usuario

4.1 Introduccidén

QuikCast es un programa de simulacion que nos permite el analisis del proceso
de moldeado, incluyendo los efectos de llenado, solidificacion y las propiedades

mecanicas.

4.1.1 Glosario
Estudio

Modelo
Superficie
Region
Volumen

Malla de superficie

Malla de volumen

Archivo de trabajo

Archivo de resultados

Es el disefio, el andlisis y los datos de resultados de una
simulacion de analisis.

Es el conjunto de piezas que forma el estudio.

Es el componente basico del que esta formado la malla.
Es el conjunto de superficies.

Es un conjunto de regiones.

Es una red estructurada en la el componente basico tiene
forma de triangulo.

Es una red estructurada en la que el componente basico
tiene forma de cubo.

Es el archivo donde se crea el modelo.

Es el archivo que crea el programa una vez realizados los
calculos y es donde se analizan los resultandos obtenidos.
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4.1.2 Entorno
Al ejecutar QuikCast vemos una ventana con diferentes zonas:

& QuikCAST 2011

File Options Matericl Datebase View Tooks Help

EN=) @

Select or desslect an object. {Modfiers: Shift=Extends Selection) Selected: 1 object

Figura 4.1

Cuando se abre un archivo se observa que tenemos nuevos menus disponibles:

Barra de meniis [Barra de herramientas

Area de trabajo

)

e e i St tnt] e s

Figura 4.2
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-Barra de menu:

La barra de mend presenta todas las opciones disponibles para la preparacion y
resolucion de un estudio

-Barra de herramientas

La barra de herramientas muestra los iconos de acceso directo a los pardmetros de
visualizacion y de configuracion. Estas se pueden mover libremente por cualquier lugar
de la ventana principal.

-Area de trabajo
El 4rea de trabajo muestra graficamente la pieza y permite modificar su visualizacion.
-Barra de estado

En la barra de estado se describen las operaciones en curso.

Camara

- Para girar la vista, pulse y mantenga pulsada la ruleta y mueva el raton.

- Para acercar y alejar la vista, gire la ruleta hacia delante para alejar la vista y
hacia atrés para acercar la vista. (también se pueden usar las teclas F2 y F3, pero
en este caso el zoom es por pasos).

- Para mover la vista, presione y mantenga pulsada la tecla Ctrl y la ruleta del
raton.

- Para rotar la vista, pulse y mantenga pulsado la tecla Ctrl, la tecla Mayus y la
ruleta del raton.

Menu contextual

El mend contextual es el mend que sale cuando haces clic con el botdn derecho
en un punto del area de trabajo. Este mend nos muestra las siguientes opciones:

- Show... y hide: Estas opciones permiten configurar la visualizacion del modelo
actual.

- Select/Deselect all: Esta opcion permite seleccionar o deseleccionar todos los
objetos del area de trabajo.

- Labels: Esta opcion permite mostrar u ocultar las etiquetas del modelo.

- Delete Annotations: Esta opcidn permite borrar las anotaciones del modelo.

- Edit Attributes: Esta opcion permite modificar la visualizacion de nuestro
modelo.
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Barra de herramientas

Standard
B
=
EEl
=

Vertex

Views

@
d Ly xd

La barra de herramientas sirve para acceder rapidamente a los comandos mas
utilizados. EI mena View -> Toolbars permite seleccionar las barras de herramientas
que queremos mostrar u ocultar.

Las barras que se tendran que tener activas son las siguientes:

,=_|j E:EE Wertex vf.;;@-

Crea un nuevo estudio.
Abre un archivo de trabajo (“.Pmf”) o de resultados (“.MCQO”)
Guarda el modelo actual en “.Pmf”.

Organiza todas las ventanas abiertas horizontalmente de manera
que el modelo es completamente visible.

Organiza todas las ventanas abiertas verticalmente de manera que
el modelo es completamente visible.

Organiza todas las ventanas en cascada de manera que el modelo
puede ser total o parciamente visible.

Especifica la seleccion de referencia para las herramientas que
utilizan localizaciones mas precisas.

Muestra la ayuda en linea de QuikCast.

Restaura las vistas personalizadas del modelo activo.

- Cambia la vista en los diferentes ejes.
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Rendering

e W T

;:J

Muestra el modelo activo con la malla de superficie.

" Muestra el modelo activo con las caras opacas.
i Muestra el modelo con las caras opacas y la malla de superficie.
2! Muestra todas las partes del modelo traslucidas.

" Muestra cada cara como una superficie plana.

* Muestra los bordes de las caras redondeados.

B Ajusta la vista en perspectiva.

#  Ajusta la vista en profundidad.

Geometry

Disefia el molde.

Disefia la entrada en una superficie plana.

Disefia formas en 2D y 3D.
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4.2 Para empezar

Debido a que QuikCast solo permite dibujar geometrias sencillas, lo mas facil y
seguro, es realizar el disefio de la pieza en cualquier programa de dibujo, siempre y
cuando sea posible guardar el archivo con la extension “.stl”". Para evitar problemas de
reconocimiento de volimenes en fases posteriores, es aconsejable incluir en un Gnico
archivo de dibujo todas las partes del producto final que se obtiene: pieza propiamente
dicha, sobraderos, bebedero y canal de alimentacion.

Sobraderos

Bebedero

anal de
alimentacion

Figura 4.3

Otra forma de realizar el disefio es dibujar el producto final por partes, pero para
ello, hay que ubicar cada parte en el lugar donde situaria. Esto se debe a que el origen de
referencia que asume QuikCast al importar los archivos, es el mismo origen que
tenemos en el programa de dibujo.

Respecto al bebedero, QuikCast s6lo permite bebederos de forma cilindrica o
paralelepipeda. Como lo habitual es que tenga forma cénica, es necesario disefiarlo
como parte de la pieza (ver figura 4.3). La cuestion es que de esta manera QuikCast no
reconoce el bebedero como entrada, y hay que crear con el programa un volumen de
entrada y conectarlo con dicho bebedero. Por ello, cuando se disefie (dibuje) el bebedero
en el programa de cad, resulta necesario recortar su altura original una cantidad, para
que el volumen entrada de forma cilindrica creado con QuikCast tenga una altura igual a
la que se ha quitado de la original y un didametro igual o inferior a la seccion superior del
bebedero dibujado.

Una vez terminado el disefio de la pieza guardamos el archivo con la extension
“.stl”.

Hay que tener en cuenta que QuikCast no permite realizar modificaciones en el
dibujo una vez cargado, por lo que si es necesario realizar alguna modificacién, hay que
hacerlo en el archivo de disefio.
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En el momento de guardar el archivo se deben comprobar las opciones de
exportacion. Para ello iremos a Opciones y comprobaremos que la Unidad de tolerancia
esté en milimetros

M Guardar como

Guardar en: |&} Planos Pieza Provecto e | @

LEUECHE Opciones de exporiacion STL |.'X | Modifica &
() PiezaCompl — 181220
entrada_del Tolerancia de conversion: 1zf1zizc
entrada_tra : ) 13/12/2C

G entrace Uridad de toleancia
Macho nidad de tolerancia: |[iHGEN v D312i20

Pieza comply  Angula del plano de la superficie: 45007 17/12f2C

Pieza oA  Gepersr el archiva como w122t

1| Pieza complg o 0312120
Pieza compld © Binario Oasti 12f1zfzCv
< >

Archivo de anotaciones

Morbre de archiv

Gauardar como tip

Figura4.4
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4.3 Menus

4.3.1 Menu File
El mend File proporciona las siguientes opciones:
| Mew Chrl+N
= Open ... Crl+0
Close
Irnport ...
Export ...
Duplicate ...
Rename Yersion ...
B save Ctrl4S
Save As...
PastScript ...
Raster ... Ctrl+P
Console ...
1 PiezaConEntrSobredim, prmf
) Ext
Figura 4.5
New Permite crear un nuevo estudio en una ventana nueva.
Para crear un nuevo estudio hay que introducir el nombre del
estudio, el programa creara una carpeta con ese nombre para
guardar los archivos de trabajo y resultados, se elige la ubicacién
donde se crea el estudio y se selecciona el archivo de disefio que
se quiere abrir. Aparece una pantalla donde se indica en que
sistema y unidades se abre el archivo. Si la opcion Automatic
Mesh Fixing esta activa se abre una ventana donde se indican los
errores producidos en la malla de superficie al importar el archivo
y nos permite solucionarlos automéaticamente.
Open... Abre en una nueva ventana un archivo de trabajo (“.PMF) o de
resultados (“.MCQO”).
Close Cierra todas las ventanas activas.
Import Importa la geometria de diferentes archivos con distintos formatos

en la ventana actual. Para importar un nuevo archivo se selecciona
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Export

Duplicate
Delete Version
Change Version
Add Version
Rename Version
Save

Save As...
PostScript...

Raster...

Console...

1...10

Exit

4.3.2 Menu Edit

El mend Edit nos proporciona las siguientes opciones:

el archivo que se quiere importar y a continuacién Aparece una
pantalla donde se indica en que sistema y unidades se abre el
archivo. Si la opcién Automatic Mesh Fixing esta activa se abre
una ventana donde se indican los errores producidos en la malla
de superficie al importar el archivo y nos permite solucionarlos
automaticamente. Se puede repetir esta accion todas las veces que

sea necesario.

Exporta la geometria de la ventana actual a distintos tipos de

formato.

Hace una copia de estudio actual.
Elimina la version seleccionada.
Cambia la version seleccionada.
Afade una version al estudio actual.

Cambia el nombre de cualquier version existente.

Guarda el archivo “.PMF” en el directorio del proyecto.

Permite guardar el archivo “.PMF” en otro directorio.

Guarda el archivo en la ventana actual en formato “.ps” 0”.dtb”.

Guarda la ventana actual en un formato “.TIFF”, “JPEG” o

“.BMP”.

Abre una ventana con el registro de la informacion del sistema.

Enumera los diez ultimos archivos abiertos y permite abrir

cualquiera de ellos

Cierra todas las ventanas y se sale de la aplicacion.
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Select All

Deselect All

Selection List...

Verify Selection...

Find...

Annotations...

Attributes. ..

Select Al Chrl+a

Selection Lisk ..,

Find ... Ckrl+F

Annotations ...

Atkribukes, ., Chel+T
Figura 4.6

Selecciona todos los objetos de la ventana actual afiadiéndolos a
la lista de seleccion del esstudio activo y se vera afectado por las
operaciones siguientes.

Anula la seleccion de todos los objetos seleccionados.

Abre una ventana que permite afiadir y eliminar objetos de la lista
de seleccion.

Abre una ventana que muestra informacion de los objetos
seleccionados.

Abre una ventana que nos permite localizar y seleccionar un
elemento en la lista de seleccion.

Abre una ventana que permite editar o eliminar anotaciones en el
modelo

Abre una ventana para configurar las opciones de los objetos para
superficies, volimenes y materiales.

Attribute Editor C:\PEC\.. . \PiezaTutorial. pmf

Objects Aftributes
Wolumes MIHERE Color: - E]
entrada o
macha Wisibility: On w
pieza
Fiender Style: Face w
Tranzparency: 0 =
Show rezults:
W
%) (o)
Figura 4.7
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En esta ventana se puede observar el panel objects que sirve para
seleccionar los volimenes o regiones a los que se quiere cambiar
su visualizacion, y el panel Attributes que es donde se modifican
los atributos del objeto(s). Se puede modificar su color, su
visibilidad, su transparencia y su visualizacién (que se vea en
forma de solido, en forma de malla de superficie y mixto).

Figura 4.8 Figura 4.9

Figura 4.10

4.3.3 Menu View
El mend View permite mostrar u ocultar objetos y establecer las opciones de

visualizacion.

Este menu nos proporciona las siguientes opciones:
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Show Regions Cnly
Show alloy Yolumes Only

Show All

Show Meshed volumes Only

Show Regions Only

Show Alloy Volumes Only
Hide Selected

Hide Unselected

Toolbar

Section Manager

View Manager

Volume Manager

Free Points

Model Origin

Labels

Toolbar 3
i3
S Wiew Manager ...
W

Free Painks

Model Origin

Labels >

Figura 4.11

Muestra todos los objetos del modelo.

Muestra solo los volumenes a los que se les ha
creado la malla de volumen.

Muestra solo las regiones del modelo.
Muestra solo los volimenes de la pieza.
Oculta los objetos seleccionados.
Oculta los objetos no seleccionados.

Muestra u oculta las barras de herramientas que
permite acceder rapidamente a los comandos mas
utilizados.

Permite cortar una seccion del modelo. Esta opcion
esta disponible para el archivo de resultados.

Restaura las vistas personalizadas.

Controla el niamero de volimenes cargados en el
archivo resultados con el fin de optimizar las
prestaciones.

Muestra u oculta los puntos libres.

Muestra u oculta el punto donde estd situado el
origen de coordenadas del modelo.

Muestra u oculta las etiquetas de los elementos.
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4.3.4 Menu Model

El men( Model nos permite administrar las mallas, las regiones y los volimenes.

Este mend nos proporciona las siguientes opciones:

Mesh Checks

Mesh Repair k
Mesh Basic Shapes »
Mesh Edit »
Mesh Delete r

Domains Manager

30 GridfMesh Generation

Mesh Checks

Mesh Repair

Mesh Basic Shapes

Figura 4.12

Esta opcién comprueba que la malla de superficie,
las caras y las superficies del modelo estan dentro
de las tolerancias establecidas.

La opcion Automatic Mesh Fixing permite analizar
la malla de superficies en busca de posibles errores
y permite solucionarlos automaticamente. Esta
opcién se puede activar al abrir o importar un
nuevo archivo marcando la casilla Automatic Mesh
Fixing.

La opcion Remesh Tool permite volver a realizar la
malla de superficie cambiando el tamafio de la
malla.

Permite disefiar el molde y/o formas 2D/3D.

Para definir el molde hay que utilizar la funcion
Mold. Aparece una ventana donde se introducen las
dimensiones, el molde se define introduciendo la
distancia de las caras del molde con el origen de
referencia del molde. Se debe tener en cuenta que
el origen de referencia del molde se encuentra
ubicado en el origen de coordenadas del modelo.
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Mesh Edit

Mesh Delete

Croate Mold... C:\... Pleza completa ok st

Figura 4.13

Para crear le entrada se utiliza la funcion Inlet,
aparece una ventana en la que se introduce la
geometria y la posicion de la entrada.

O Parallelepiped

Figura 4.14

También se puede crear algunas geometrias
sencillas segun lo que se quiera realizar utilizando
las siguientes funciones:

- Cylinder: Crea un cilindro.

- Circle: Crea una superficie circular.

- Parallelepiped: Crea un paralelepipedo.

- Rectangle: Crea una superficie rectangular.

- Extrude: Extruye una superficie seleccionada

Esta opcion permite modificar puntos, superficies y
regiones. Solo es posible modificar uno por uno.

Permite eliminar puntos de la malla de superficies
0 regiones.
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Domains Manager

Permite crear, modificar o eliminar regiones y
volimenes del modelo.

Domains Manager C:\...\Pieza complela sk 1.5tl E

ol s

8

Matenal

Hore
Mors
Mors
Maorsy

Bugtomats: wolume celecinn

Woharet | Fiegon: | dr Venting Regons

Type

Avalable Fegomn

al @
EXTFAVOLUME _D0

AL (fn, ]
EXTFAVOLUME_DOz
EXTFVOLUME 004
INTFAULUME N UILLIME L
INTFAOLUME _O04-F0LLIME _
INTFAOLUME 00 S0 LLME _004
INTFAOLUME 003 DLLUME _002
INTFAOLUME D02 OLUME D03
INTFAOLUME_O04-DLLIME _002
INTFAOLUME D024 0LLIME 004

ﬂ £ »

Higtenal Irberface

Correctad sspaon mesh f:"'f'ﬂ 'E}H{l
[5] Crnate cortact ingion D
Bautomalic voluma debection friched
Stshu
‘ Wolgmas ‘ st
Coe || Hep |
Figura 4.15

En esta ventana se puede observar los diferentes
paneles. En el panel Volumes hay una lista que
muestra los volumenes que estan disponibles, a la
derecha hay unas flechas que permiten ordenarlos
por orden de llenado, dejando al final los moldes.
El panel Available Regions muestra una lista con
todas las regiones que hay en el modelo, a la
derecha hay unos botones que permiten modificar
la lista de los volimenes y de las regiones y
asignarles el material correspondiente. El panel
Automatic Volumen Detection permite crear los
volumenes automaticamente. El panel Material
Inteface crea nuevas regiones en base a la
definicion de los materiales. El panel Status
comprueba si estan bien definidos los volimenes y
los materiales.
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3D Grid/ Mesh Generation Permite dividir el modelo en cuadriculas a los largo
de los ejes X, Y, Z y generar la malla de volumen

G
L ¢

E 30 Mesh Generation C:\...\Plez:

g [y [ g sobre las piezas.

s Para realizar el mallado de la pieza deben estar

— == seleccionados Unicamente los volumenes que

pertenecen a la pieza y no los pertenecientes al

Macho s . = ~

Maide molde. Aqui se puede definir el tamafio de la malla,
indicara el numero de celdas que ha creado,

e 0005 generara la malla y comprobara si se ha generado

Max Soe 002 -

Max Geowth Rate 11 blen Ia ma”a.

MinSee 0001

[ 2epb || unds | [Resmern el God|

Gnd Informaton

Nusnbes of Cols 21952
20 Rato cotony OK
v (Detaks_]

Meth Genecabor
Mech completed
v

[77Rl“r l \‘ CD;&:J

[ ome | [_Heo

Figura 4.16

4.3.5 Menu Material Database

El mend Model nos proporciona las siguientes opciones:

Material Database

Alloy Material ...
rlold Material ...
Die Coating Makerial ...

Figura 4.17
Alloy Material... Muestra la base de datos de los materiales para la pieza.
Mold Material... Muestra la base de datos de los materiales para el molde.
Die Coating Material... Muestra la base de datos de materiales para recubrimientos.
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4.3.6 Menu Process

El mend Process nos proporciona las siguientes opciones:

Gravity...

Input Data Check

Process

Grawvity ...

Input Daka Check,
Solidification Material Parameters ...

Figura 4.18

Permite especificar el valor y la direccion
de la gravedad. Dependiendo de como se
haya realizado la pieza en Solid Edges la
gravedad llevara una direccion por lo que
se debe comprobar que la gravedad este
definida en la direccion correcta.

Permite acceder a la lista de las condiciones
de contorno.

Las condiciones de contorno que dispone QuikCast se dividen en hidraulicas y
térmicas. A continuacion se explican las condiciones hidraulicas:

Initial Fluid

Inlet

Pressure

Velocity

Piston

Permeability

Air Venting

Filter

Ceramic Foam Filter

Se utiliza para representar la llegada del metal por la
entrada o definiendo un volumen inicial de fluido.

Se utiliza para crear la alimentacion del metal con una
determina velocidad sin que se defina un volumen.

Se utiliza para definir la presion en una region o volumen.

Se utiliza para definir la velocidad de alimentacion del
metal.

Se utiliza para simular el desplazamiento del piston en la
camara de inyeccion.

Se utiliza para simular el escape del aire a través de la
porosidad del molde.

Se utiliza para definir una salida de aire en el modelo.

Se utiliza para simular los efectos de filtrar con rejilla en el
modelo.

Se utiliza para simular los efectos del filtro de espuma
ceramica.
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Region Roughness

Flow Paths

Se utiliza para tener en cuenta los efectos de la rugosidad
sobre las paredes.

Se utiliza para cambiar el color del flujo segun va entrando
en las secciones.

Ahora se explican las condiciones térmicas:

Temperature

Heat Transfer Coefficient

External Exchange

Implicit Mold

Die Coating

Heat Flux

Thermal coefficients

Exothermic Material

Extended Regions

Air Gap

Contact Resistance

Cooling

Die Spray

Mold Opening

Se utiliza para definir la temperatura en una region
o0 volumen.

Se utiliza para definir el intercambio de calor
interno.

Se utiliza para definir el intercambio de calor con
el exterior.

Se utiliza para definir el efecto hidraulico y térmico
en el molde sin el mallado.

Se utiliza para definir el efecto térmico debido a
los recubrimientos del molde.

Se utiliza para imponer un flujo de calor uniforme
en una region.

Se utiliza para definir los coeficientes de
intercambio de calor.

Se utiliza para definir el material de aislamiento.

Se utiliza para incrementar el intercambio de calor
entre dos areas.

Se utiliza para tener en cuenta la separacion del
aire en el intercambio térmico.

Se utiliza para imponer una resistencia térmica en
una region.

Se utiliza para simular el efecto de la refrigeracion.

Se utiliza para definir los efectos térmicos debido
al revestimiento de aire y agua en el moldeo a
presion.

Se utiliza para definir los efectos térmicos debido a
las operaciones de apertura y cierre de un molde
permanente.
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Third Stage Effect

Solidification Material Parameters...

4.3.7 Menu Standard Calculation

En este mend tenemos las sig

Se usa para tener en cuenta el efecto de la presion
residual durante la tercera etapa de procesos de
fundicion a baja y alta presion.

Permite modificar los parametros de
solidificacion del material

uientes opciones:

Standard Calculation

Outpuk Pararmeters ...
Contral Parameters | .,

Calculation Skart

Calculation Monitor ... #

Output Parameters...

Control Parameters...

Calculation Start

Figura 4.19

Gestiona la frecuencia de salida y los puntos de
seguimiento necesarios para los calculos de
resultados. Esta opcion permite modificar los
pardmetros y las frecuencias de la salida de datos
pudiendo elegir cuando recoge los datos en funcion
del porcentaje de llenado o del tiempo dependiendo
gue sea mas interesante para el analisis posterior.

Permite configurar los parametros relacionados con
la resolucion.

Gestiona las opciones para los calculos de la
solucion. Aparece una ventana donde se elige el
proceso que se realiza y permite configurar dichos
parametros.
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Calculation Monitor...

Filling S olidification
Filling and Solidification Cyecling Advanced Parasity

Calculstion type

(=) Standard caloulation
Initial cavity temperature [*C): 20

Initial mold temperature ["C): 20
() Start from mold thermal field
() Resume from filling
(O Resume filing from solidification

Stop Filling Criteria
Maximumn time: [s) ED

Percent of cavity filed

100
Stop Solidification Criteria
M axirumm time: [ 1000
M ax temperature [*C): 538
Optionz
@ None O High Fressure
Processors
Number of Processors 1/ :
Fost-Treatment
[ Advanced Parosity Calculation
l Check data ] l Save ] l Fun

B

Figura 4.20

Comprueba el progreso de los célculos.

Calculation Monitor

Filing | Solidification

Study location Version

I WER v| . [w |~

Time stepfs]  Min1e-006s at e 0005 Mas=0.0019s at time 0101
00019

Te-006

Time(s)
Percent flledi]  75.33% at fine 4.34s

100.0

0o
0.00 4.34
Timels)
Summary
Calculation is runring
Run submitted on - Tue Dec 18 10:36:43 2012

Step Number 2664
Simulated Time 4.35s
Elapsed Time 242,005

Figura 4.21

Pagina 37 de 107



4.3.8 Menu Advanced Calculation
En este mend tenemos dos opciones:

Advanced Calculation

Risering Optirization »
Robustnessfatochaskic Analysis (beta wersion)  #

Figura 4.22

Risering Optimization Permite optimizar automaticamente el calculo del
didmetro que debe tener la entrada

Robustness/Stochastic Analysis Permite administrar la robustez de los calculos.

4.3.9 Menu Results
El mend Results permite analizar los resultados obtenidos tras los célculos.

Este mend solo se encuentra disponible cuando se abre el archivo de resultados
(“.MCO”). Para ello lo primero que se debe hacer es abrir el archivo de resultados con
la extension “.MCO” que se encuentra en la misma carpeta que el archivo de trabajo y
para analizar mejor los resultados solo se abriran los volumenes que pertenecen a la
pieza.

En este mend nos encontramos las siguientes opciones:
Mesh Correction Factors ...

Filling/Solidification ...
Process Synopsis ...
Mechanical Properties ...

Curves ...

Figura 4.23

Mesh Correction Factors... Se usa para comprobar de forma visual el porcentaje de
Ilenado afectado de cada celda de la malla.

Filling/Solidification... Esta opcion permite ver los resultados del llenado y la
solidificacién del modelo de forma animada. Se puede ver
con diferentes opciones el llenado y la solidificacion.
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Filling / Solidification C:\PFC....\Prueba.meo [ )[51/X] Filling / Solidification C:\PFCY....\Prueba.mco (2 |[01/X]
Simulation Fesults Simulation Results
Type: |Filing | [Ashowtiqud [ &) Type: | Solidfication | M showtigud  [1..] &
Results Type: |Fill Rate - E Results Type: | Liquid Fraction v ﬂ
Selection ! s [ Time Seleckion s | Time
Single State Fill Time B 0: 0.000000 A Single State B 0:10.145967 A
None E 1! 0508250 ae 1@ 15.352306
e 2@ 1.013008 Skake 2:19.221439
IS:CI?;:nent: A ﬂ Skake 3: 1.517262 Is:ch:;:nent: ﬂ ﬂ Stake 3: 22497717
Stake 4: 2021266 Sktate 4: 27012375
Stake 5 2536736 Skate 532060055
J J J J J State &: 3.040724 J J J J J State & :36.767639
State 7@ 3544738 Skake 7:43.129051
State 8: 4.045754 Skake &:50.155349
State 9 4.564357 Skate 9: 56,303059
State 10 : 5.063615 v State 10 : 63.540359 bt
[ Update ] [ Close ] [ Help ] [ Update ] [ Close ] [ Help ]
Figura 4.24 Figura 4.25
Process Synopsis... Nos muestra los resultados del proceso de fundicion, de
los célculos de defectos y la solidificacion de manera
especifica.

Mechanical Properties. .. Se utiliza para calcular las propiedades mecéanicas del
material tras un tratamiento térmico.

Curves... Muestra los resultados de los puntos afiadidos en forma de
curva en un gréfico.

Particles Tracing... Esta opcion superpone los resultados de una o varios
puntos de nuestro modelo.

Color Scale Parameters... Nos permite configurar los colores asociados a cada
resultado.

4.3.10 Menu Tools
En este mend nos encontramos las siguientes opciones:

A356[357 AlSi7MGN.3/0.6 Heat Treatment Advisor
J'T Thermal Interpolation
Calculation Scripk

Surface, Yolume & Mass

Figura 4.26
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Concat Comprime dos archivos de resultados. Para poder
abrir el archivo necesitas extraerlo con la siguiente

opcion.
Extract Extrae los archivos de resultados.
Run Control Estima la memoria necesaria para resolver el

proceso de llenado o de solidificacion.

A356/357 AISi7Mg0.3/0.6 Heat Treatment Advisor

Permite estimar las propiedades mecénicas después
de un tratamiento térmico.

Thermal Interpolation Permite interpolar entre los archivos que tienen
diferentes resultados de mallado.

Calculation Script Permite encadenar diferentes resultados.

Surface, Volume & Mass Calcula el volumen, la superficies y la masa de los
objetos seleccionados.

Project Cleaner Permite limpiar los archivos temporales generados
durante los célculos.

4.3.11 Menu Options

En este mend nos encontramos las siguientes opciones:

Opkions

camera ..,
File Extensions ...

Graphics ...
Chart...

Executable Locations. ..
User Database ...
Skudy Location.. .

Figura 4.27

Camera... Activa la camara cuando el raton se mueve por una
ventana del programa.

File Extensions... Especifica por defecto las extensiones del nombre
del archivo.

Graphics. .. Establece las preferencias graficas del modelo
activo.
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Chart...

Executable Locations...

User Database...

Study Location...

4.3.12 Menu Window

Establece las preferencias de estilo de graficos del
modelo activo.

Define la ubicacion del generador de mallas.

Define el nombre y la ubicacion de la base de datos
del material usado por defecto.

Define la ruta predeterminada para la ubicacion de
un nuevo estudio.

En este mend tenemos las siguientes opciones:

T Window
B Cascade
E Tile Horizontal

EE Tile Wertical

Arrange Icons

v 1 Pre-Processing Project [PiezaConEntrSobredim] version[+0] - C:\PFC\Eeovanny _albertolPruebas|PiezaConEntrSobredim’w0

New Window

Cascade

Tile Horizontal

Tile Vertical

Arrange Icons

Figura 4.28

Abre una nueva ventana que muestra el modelo
activo en su orientacion predeterminada.

Organiza todas las ventanas abiertas una detras de
otra mostrando la barra del titulo.

Organiza todas las ventanas del modelo abierto en
forma horizontal desde la parte superior a la parte
inferior del &rea grafica y cambia el tamafio de
cada uno de ellos a fin de que todos ellos sean
completamente visibles.

Organiza todas las ventanas del modelo abierto en
forma vertical desde la parte lateral del area grafica
y cambia el tamafio de cada uno de ellos a fin de
gue todos ellos sean completamente visibles.

Organiza las ventanas minimizadas del modelo a lo
largo de la parte inferior de la ventana.

Aparecen todas las ventanas abiertas. El icono v
muestra la ventana activa.
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4.3.13 Menu Help

En este mend tenemos las siguientes opciones:

@ Help Conkents F1

Session ...
About...
Figura 4.29

Help Contents Abre la ayuda en linea en su pégina de inicio.
Session... Muestra las propiedades del hardware y software de la

sesion activa.
About... Muestra el aviso de copyright y el nmero de version de la

aplicacion.
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Capitulo 5: Manual profesor

5.1 Creacion y gestion de planos

Debido a que QuikCast solo permite dibujar geometrias sencillas, lo mas facil y
seguro, es realizar el disefio de la pieza en cualquier programa de dibujo, siempre y
cuando sea posible guardar el archivo con la extension “.stl”". Para evitar problemas de
reconocimiento de volimenes en fases posteriores, es aconsejable incluir en un Gnico
archivo de dibujo todas las partes del producto final que se obtiene: pieza propiamente
dicha, sobraderos, bebedero y canal de alimentacion.

Sobraderos

Bebedero
Pieza

anal de
alimentacion

Figura 5.1

Otra forma de realizar el disefio es dibujar el producto final por partes, pero para
ello, hay que ubicar cada parte en el lugar donde se situaria si estuviera la pieza. Esto se
debe a que el origen de referencia que asume QuikCast al importar los archivos, es el
mismo origen que tenemos en el programa de dibujo. Por este motivo en nuestro caso,
para evitar que el alumno tenga problemas en el momento de realizar la simulacion, se
elige la primera forma de hacer el disefio.

Respecto al bebedero, QuikCast solo permite bebederos de forma cilindrica o
paralelepipeda. Como lo habitual es que tenga forma cénica, es necesario disefiarlo
como parte de la pieza (ver figura 5.1). La cuestion es que de esta manera QuikCast no
reconoce el bebedero como entrada, y hay que crear con el programa un volumen de
entrada y conectarlo con dicho bebedero. Por ello, cuando se disefie (dibuje) el bebedero
en el programa de cad, resulta necesario recortar su altura original una cantidad (en este
caso 5 mm), para que el volumen entrada de forma cilindrica creado con QuikCast tenga
una altura igual a la que se ha quitado de la original (5 mm) y un diametro igual o
inferior a la seccidn superior del bebedero dibujado.

Otro aspecto importante es el macho. En este caso no es necesario introducirlo
por dos motivos: al ser el macho del mismo material que el molde, el programa los
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considera como una sola parte; el otro motivo es que no necesitamos introducir ninguna
condicion en el macho a la hora de simular el moldeo. Por tanto en el archivo de disefio
de pieza se realiza ya con el agujero del macho.

Una vez terminado el disefio de la pieza guardamos el archivo con la extension
(13 2
stl”.

Hay que tener en cuenta que QuikCast no permite realizar modificaciones en el
dibujo una vez cargado, por lo que si es necesario realizar alguna modificacion, hay que
hacerlo en el archivo de disefio.

En el momento de guardar el archivo se deben comprobar las opciones de
exportacion. Para ello iremos a Opciones y comprobaremos que la Unidad de tolerancia
esté en milimetros

Guardar en: |2 Planos Pieza Provecto w| | @

Nambre Opciones de exportacidn STL §| Modifica 14
PigzaCompl 1af12120
entrada_del Talerancia de conversidre | 0,01 1zf12fzC
1] entrada_t ) . 13f12j2C
:.ln r;: L Unidad de tolerancia: w DS;IZ;ZE

acho
Pieza compld  Angulo del plano de la superficis: 45,00 17hzfzc
Pieza COMPY  Gopersr el archiva como b3f12f2t

21| Pieza compld o 0312120
Pieza complg © Binario Oasti Lzf1zfzi v
< ¥

Archiva de anotaciones
Mombre de archiv
—
Guardar coma tip Cancelar
Figura 5.2

5.2 Creacion de un nuevo estudio
A continuacion abrimos el programa QuikCast y creamos un nuevo estudio. Para

ello vamos al mend File -> New o iremos al icono =' en la barra de herramientas,
apareciendo la siguiente ventana:
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Study
MName: | Pigzal

Werzion Mame: |0

Location: | C:\PFCAWPara entregar

Impart PHF File

Figura 5.3

En el apartado Name introducimos el nombre que se quiera dar al estudio. A
continuacién vamos al apartado Location y hacemos clic en el botén [ para elegir la
ubicacién donde se guarda el estudio. Hacemos clic en Ok.

A continuacion se abre una ventana donde buscamos el archivo de disefio. Luego
hacemos clic en Open para abrir la pieza en el area de trabajo, apareciendo ahora otra
ventana donde se eligen las opciones de importacién del archivo.

Import File options C:\... EJ
CAD Units System

Impart File :

Length: | wilimeter

wWelding
On/off

Talerance [mm] : | 0.001

tMezh Repair
Automnatic Mesh Fiking

[ 0k I [Eancel] l Help ]

Figura5.4

En los apartados Import File y Lengh se elige Metric y Milimeter
respectivamente. Es importante que las unidades sean las mismas que las que tiene el
archivo "".stl”", ya que si no es asi, variaran las dimensiones de la pieza

La opcién Welding sirve para unir los puntos, generalmente perteneciente a dos
regiones diferentes, si se encuentran situados con una diferencia inferior a la de
tolerancia mostrada.. Esta opcion se encuentra activa por defecto, y en nuestro caso la
dejaremos asi. A continuacion activamos la opcion Automatic Mesh Fixing para que el
programa compruebe automaticamente si hay algun error en la geometria que se va a
abrir. Para terminar hacemos clic en Ok
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Luego aparece una ventana que indica los errores que se han encontrado en la
geometria de la pieza. Para reparar los errores automaticamente hacemos clic en Yes.

Automatic Mesh Fixing Res...

“Para entregarFlanos\Pieza original stl

0 Coplanar ¥
@ 0 Free edge 9
B rusmalse  y¢

‘Warning : too much errors [ > 600]
Automatic Mezh Fiking can be too long

Do you want to perform
1Y, Automatic Mesh Fising 7
LAY

Figura 5.5

Ahora ya se puede observar que la pieza se ha abierto en el area de trabajo.

Figura 5.6

Si vamos al menu View -> Selection List observamos que el programa ha creado
la region SurfaceDomain_1, junto con otra pequefia regiébn que llama
COPLANAR_FIXEDL. Esta ultima es por defecto y no hay ningun problema porque
después cuando se generan los volimenes se soluciona.
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ir directamente al icono !

Ml Selection List Manager

Objects

(%) Element Sets | Regions - EHE

COPLANAR_FIXED
SurfaceDomain_1

X

Figura 5.7

5.3 Creacion de la entrada

. Aparece la siguiente ventana:

Create Inlet C:A\PFC\...\Pieza original.stl

Shape name
shape_name
Shape [rmm]
(%) Cylinder ) Parallelepiped
Diameter. |9
Height: |5
Laocation [rmm)
w58
v (500 %
7. |E5

[ Reverse arientation Connected region mesh

Figura 5.8

Si fuese necesario afiadir otra pieza o algin elemento necesario para la
realizacion del moldeo, como por ejemplo, un macho (recordamos que en nuestro caso
no es necesario afadir el macho) hay que ir al siguiente mena: File -> Import. A
continuacion aparecerd una ventana donde elegimos el archivo que se quiera abrir.
Repetimos el mismo proceso utilizado para abrir un nuevo archivo.

Para crear la entrada hay que ir al ment Model -> Mesh Basic Shapes -> Inlet o
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En esta ventana tenemos las opciones geométricas y de ubicacion de la entrada

dividido en los siguientes apartados:

Shape name: permite modificar el nombre que se le asigna a la entrada. En este
caso dejamos el nombre que aparece por defecto.
Shape: permite elegir la forma de la entrada que queremos crear y sus
dimensiones en mm. Seleccionamos la opcion Cylinder e introducimos:

o Diametro 8

o Altura 5
En este caso escogemos este diametro porque, en realidad, el fluido no entra por
toda la superficie sino solo por una zona. De esta forma podemos realizar una
simulacion del llenado més cercana a la realidad. La altura del cilindro es porque
se ha recortado el bebedero 5 mm.
Location: permite definir las coordenadas de la ubicacion de la entrada. Estas
coordenadas hacen referencia al punto central de la base de la entrada. Como
muestra el punto rojo de la figura 5.9

Figura 5.9

Para colocar la entrada pinchamos en la zona donde se quiera situar la entrada v,
a continuacion introducimos las siguientes coordenadas; X=58, Y=50 y Z=65.
Estas coordenadas se obtienen desde el origen de referencia de la pieza hasta la
parte superior del bebedero. Hemos elegido esas coordenadas para que el fluido
caiga primero en la conicidad del bebedero, para evitar que la colada caiga
directamente en fondo del canal de alimentacion. Se puede elegir cualquier
punto, siempre y cuando la entrada este dentro de la parte superior del bebedero.

Connected region mesh: esta opcion permite conectar la pieza con la entrada.
Tenemos que activar esta opcion puesto que queremos unir la entrada con el
bebedero.

Reverse orientation: permite cambiar la direccion de la orientacion de la entrada.
Activamos esta opcién si la orientacion de la entrada es la opuesta a la que
gueremos. Esto quiere decir si activa la entrada en vez de hacer la entrada hacia
afuera de la pieza, se hace hacia dentro de la pieza.

Para crear la entrada haremos clic en el boton Apply.
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La entrada estd formada por tres region: Bottom(tapa del cilindro), Core (cara
lateral del cilindro) y Top(base del cilindro). Para comprobar que se han creado iremos
al mend View -> Selection list. Aqui apareceran las tres regiones que forman la entrada.

I Selection List Manager, g|
Objects
(%) Element Sets | Regions v ﬂ == e

Figura 5.10

En el caso de que nos hayamos equivocado en la definicion de cualquier
parametro de la entrada, tenemos que borrar la entrada y volver a crearla ya que no se
puede modificar. Para borrar la entrada iremos al mend View -> Selection list y
seleccionamos las tres regiones pertenecientes a la entrada. Una vez seleccionadas le
damos al botén Add y, a continuacion le damos a la tecla Suprimir. Entonces aparece un
mensaje de confirmacion para borrar dichas superficies, le damos a Delete y se borrara
la entrada. Una vez borrada la entrada, aparece un agujero en la malla del bebedero ya
que ambas piezas estaban conectadas. Para reparar la malla del bebedero, iremos al
menu Model -> Mesh Repair -> Automatic Mesh Fixing, apareciendo la siguiente
ventana:

£ Automatic Mesh Fixing C:\... g|

tezh Duality
[ Check Mesh Quality ]

A Coplanar

@ Free edge

@ Small zize
tlesh Fising

0%
Figura 5.11
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Esta opcion permite reparar automaticamente la malla. A continuacion hacemos
clic en Check Mesh Quality para ver los fallos que tiene la malla de la pieza. Una vez
comprobados los errores se hace clic en el boton Fix y la malla se repara
automaticamente. Ahora que se ha reparado la pieza se vuelve a crear la entrada.

En algunas ocasiones no podemos colocar la entrada en el punto que queremos.
Para solucionarlo, pinchamos en otros puntos de la cara. Realizamos esta accion hasta
que podamos crear la entrada donde se quiera. Luego, volvemos a introducir las
coordenadas de su ubicacion. Si aun asi no se ha solucionado, salimos del mend Inlet y
volvemos a entrar. Empezaremos de nuevo a crear la entrada.

En otras ocasiones, al reparar la malla con la opcion Fix, se produce una
deformacion en la pieza. Si ocurre esto tenemos que borrar e importar la pieza ya que no
se puede solucionar.

5.4 Creacion del molde

Para crear el molde vamos al mend Model -> Mesh Basic Shapes -> Mold o
hacemos clic en el icono *®

El programa considera molde a la caja exterior del molde real, de manera que
para definir sus dimensiones, supone que es un paralelepipedo y se introducen las
coordenadas de los puntos extremos respecto al origen de coordenadas del programa.

Figura 5.12

Teniendo en cuenta que las dimensiones del molde son 150 x 150 x 140mm,
para introducir las posiciones extremas, hay que tener en cuenta donde esta situado el
origen de coordenadas (ver Figura 5.12). El resultado se muestra en la figura 5.13.
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f x|
Corners lozations Maodel Origin [ mm )
Feiininnum b aimum
w 7500 ﬂ J J ﬂ?s.an %
R ﬂ 3 J ﬂu&uu v
z 000 | 3 J | >
Figura 5.13

Introducidas las medidas, hacemos clic en Apply para crear el molde. Si antes de
cerrar esta ventana se observa algun error en las dimensiones del molde se puede
corregir. Para ello haremos clic en el boton Undo para deshacer el molde.

Si vamos al menu View -> Selection List observamos que ahora se ha creado la
siguiente region perteneciente al molde: MOLD_SURFACE_1.

Como en casos anteriores, una vez cerrada la ventana de creacion de molde
observamos algun fallo en el molde, éste no se puede modificar, por lo que hay que
eliminarlo. Para ello haremos igual que para borrar la entrada pero ahora seleccionamos
la region MOLD_SURFACE_1.

5.5 Creacion de volUmenes

Los volimenes son cada una de cavidades cerradas que forman las regiones.

Para crear los volimenes iremos al menu Model -> Domains Manager,
apareciendo la siguiente ventana:
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Domains Manager C:\PFC\...\Pieza original.stl

Volumes | Regions | AirVenting Regions

alumes Awailable Regions
%1 Pricrity 21 @

Mame M aterial Type F gar;af;r?;ga}i:r‘\im Mew ...
shapeﬁname_fBD TTOM

= shape_name_CORE
shape_name_TOP
= MOLO_SURFACE_1

L [«

Automatic volume detection Material Interface

Connected region mesh OYes @HNo

[[] Create contact region

[ ] |Compute valume ... [CJonene

Status

a Valumes

Figura 5.14

En nuestro caso solo utilizamos la pestafia Volumes, puesto que solo crearemos
los volimenes. Esta pestafia esta dividida en seis partes:

e Volumes: esta situada en la parte superior izquierda, muestra el listado con los
volumenes existentes.

e Available Regions: esta situada en la parte superior derecha, muestra el listado
de las regiones disponibles o superficies que se han ido creando o afiadiendo.

e Automatic volumen detection: esta situada en la parte inferior izquierda, muestra
diferentes opciones para crear de forma automatica los volimenes.

e Material Interface: esta situada en la parte inferior derecha y muestra el interfaz
de materiales de los volumenes que se creen. Inicialmente, y mientras no haya
volimenes creados, esta opcion estara desactivada.

e Status: esta situada en la parte inferior, este apartado nos indica si los volumenes
y materiales estan bien definidos.

e Por ultimo, en la parte superior derecha, tenemos el panel que nos permite crear,
borrar y modificar los volimenes de manera manual y el definir los materiales.

Para crear los volUimenes, intentaremos que el programa los reconozca de
manera automatica. Para ello, lo primero es asegurarnos que en el apartado Automatic
volume detection, Connected Regions Mesh esta seleccionada la opcidén No, ya que esta
opcidn permite conectar todas las regiones del modelo, creando asi un tnico volumen.

A continuacion, y dentro del apartado apartado Automatic volume detection,
activamos la casilla Create Contact Region Esta opcion permitira crear las regiones de
contacto entre todas las piezas del modelo. Luego hacemos clic en el boton

Compute valume .. nara crear los voldmenes. Antes de crear los volimenes, el programa
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redefinira las regiones existentes y creard unas regiones nuevas en las zonas de contacto
entre regiones. A continuacion se crean los volimenes en funcion de las nuevas
regiones.

Domains Manager C:\PEC\...\Pieza original.stl

Wolumes | Regions | AirVenting Flegions

Yolumes Available Regions

%1 Fricrity 21 @
Mame Material Type T Ei};xg\[ﬁmg_gg; Mew ...
VOLUME_D01  Nane e

YOLUME D02 Nane ﬂ INTFOLUME _D01-VOLUME_002

VOLUME_003  None INTF/OLUME D03 0LUME_001
j INTF-VOLLME_001-VOLLIME 003
INTF-VOLLME_003OLLIME_002

INTFA/OLUME_002-V0OLUME_003

CNEN

b »

Automatic volume detection Material Interface

Connected region mesh Oives @ MNo

Create contact regian D

Automatic volurne detection finished ...

( ) [Eompute votume .| oo

Statuz

¥ Walumnes “ Material

Figura 5.15

También aparece una ventana que permite conservar la definicion de las antiguas
regiones. Si no borramos las antiguas regiones, estas siguen apareciendo pero no tienen
ninguna relacion con los volimenes. En nuestro caso, hacemos clic en Remove ya que
no queremos conservarlas.

Remove or Keep

Do wou weant to remove or to keep the regions created before 7

| Femaove |[ Keep ]

Figura 5.16

Ahora, en el apartado Volumes aparecen los volumenes que se han creado. Se
pueden observar tres volimenes que pertenecen a la entrada, la pieza y al molde. Para
visualizar si estan bien los volimenes, utilizamos los botones situados encima de la lista
de volumenes. Si se hace clic en cualquier volumen se observan las regiones que
conforman el volumen ya que aparecen sombreados en la lista de regiones. EIl volumen
1 es la entrada (Figura 5.17), el volumen 2 es la pieza (Figura 5.18) y el volumen 3 es
el molde (Figura 5.19).
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Figura 5.17 Figura 5.18

Domains Manager C:\PFC\...\Pieza original.stl

Valumes | Regions | AirVenting Regions
Volumes Avalable Regions

al View Nest Yolume al

Hame Material Type
YOLUME_001  Mone
YOLUME 002 Mane
WOLUME 003 i e
INTFVOLOM
INTFA/OLUME [ ME 002
INTFVOLOME_002OLUME_D03

<

Autarnatic wolume detection Material Interface

Connected region mesh OYes @No

Create contact region D

Automatic volume detection finished

| |Compute volume ... ] onson

‘ Material

Figura 5.19

Es conveniente cambiamos el nombre genérico de los volumenes para
distinguirlos facilmente. Para ello hay que seleccionar el volumen y hacer clic en el
boton Rename, aparece una ventana donde escribimos el nuevo nombre.

Rename Volume

MWame: |Entrada

Figura 5.20

El siguiente paso es asignar el material para cada volumen. Para ello se
selecciona el volumen Molde y haciendo clic en Material y aparece la siguiente ventana:
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Material Yolume f'5__<|
Walumelz]
MNarme : | Molde |

Yolurme Type | [EEE v

Phyzical Properties
() Standard databaze

() User database

Materials List: | GREEN_SAND |
[ Ok ] [ Cancel l
Figura 5.21

En el apartado Volume Type se selecciona Mold y en Material List elegimos el
material. En nuestro caso es GREEN_SAND, dado que el molde es de arena. Luego
hacemos clic en Ok

Para seleccionar el material de la pieza, se selecciona el volumen pieza y en el
apartado Volume Type se selecciona Alloy. En Material List se elige el material, que en
nuestro caso es AlSi7Mg, y se hace clic en Ok. A continuacién aparece un mensaje

diciendo que todos los volumenes restantes también seran del mismo material.

Material Yolume

Yaolume[z]

Marme : |

Wolume Type |.t‘-‘«||oy

Phyzical Froperties
(%) Standard databaze

) User database

b aterials List: | Al5ithg

[ 0K ] [Eancel]

Figura 5.22

QuikCAST 2011

1 5 all alloy wolumes bvpe set ko AlSI7Mg
-

Figura 5.23

Por ultimo hay que ordenar los volimenes por el orden de llenado, dejando al
final los volumenes pertenecientes al molde. En este caso se ordena de la siguiente

manera: entrada, pieza y molde.
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Walumes

%1 ['\-"iew Walurme ][ Wiew Mext Walume Priority
M ame M aterial Type F
Entrada AlSivMg Allay
Fieza alsivtg Allowy r
Muolde GREEM_SAND told

Figura 5.24

Comprobamos en el panel de Status que los volimenes y los materiales se
encuentren bien definidos si aparece en ambos un tic verde.

AT

Wokumas M sbansl
o W

Figura 5.25
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5.6 Generar la malla

La siguiente etapa es generar la malla de la pieza. Esta malla la utiliza QuikCast
para la simulacion del llenado y solidificacion de la pieza. Por este motivo, conforme la
malla sea mas pequefia, mas precisos seran los resultados pero mas tiempo tardara el
programa en realizar los célculos.

Para ello vamos al mend Model -> 3D Grid/Mesh Generation y aparece la
siguiente ventana:

Auto | Create || Modify | Insert | Delete

Grid
() Unifarm () pudvanced

Select Valume HE ==

Average Size: 0.005
M ax Size: 0.02
M ax Grawth Fate: 11
Min Size: 0.001

Apply Riestore Initial Grid

Grid Information

Mumber of Cells : 1
2D Ratio criteria Ok

v
Mesh Generation
v
0%
[ Fun ] [ Eheck]
Claze ] [ Help ]
Figura 5.26

En esta ventana, si queremos que la generacién de malla sea de forma
automatica (como es el caso), activaremos la pestafia Auto. Aunque la generacion es
automatica, se puede modificar el tamafio de la malla. Para ello, estd la opcion Uniform,
que es la seleccionada, para que realice una division uniforme de la malla en los 3 ejes.
Si queremos que cada eje sea diferente, seleccionaremos Advanced.

En el apartado Select volumen, hay que seleccionar de la lista de todos los
volumenes aquellos que pertenezcan solo a la pieza, que en nuestro caso son entrada y
pieza.
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En los siguientes apartados se muestran los valores maximos y minimos del
tamafo de la malla. Estos valores se pueden modificar para variar su tamafio, pero en
nuestro caso dejamos los valores que vienen por defecto.

A continuacion hacemos clic en el boton Apply para obtener el nimero de celdas
en las que se dividird la pieza. Una vez realizado aparece en el apartado Grid
Information el nimero de celdas y, si se ha realizado de forma correcta, aparece un tic
verde.

Luego vamos al apartado Mesh Generation donde generamos la malla. Para ello
pulsamos el botdn Run y, una vez terminado, aparece un tic verde que indica que se ha
realizado de forma correcta. Para terminar cerramos la ventana haciendo clic en el boton
Close.

En esta ventana pueden aparecer diferentes errores:

e Sien el apartado Mesh Generation aparece una cruz roja puede ser porque no se
hayan creado bien los volumenes de la pieza al no haber activado la opcién
Create Contact Region. Para solucionarlo iremos al ment Model -> Domains
Manager y comprobaremos que la opcion Create Contact Region esté activada,
y volveremos a crear los volimenes.

e Otro error puede ser que el tamafio de la malla no sea el adecuado para la
geometria de la pieza. Para solucionar esto, modificaremos el tamafio de la malla
cambiando el valor de la casilla de Average Size.

e Si aparece un tic rojo en el apartado Grid Information es porque el valor en el
apartado Max Growth Rate no es el adecuado. Para solucionarlo introducimos en
esta casilla el valor que muestra el programa al lado de la cruz roja.

5.7 Imposicion de las condiciones de contorno

5.7.1 Gravedad

El primer punto en las condiciones de contorno, es comprobar la direccion que
lleva la gravedad. En nuestro caso es importante este apartado puesto que realizamos un
llenado por gravedad. Por este motivo, configuramos la gravedad en la direccién
adecuada teniendo en cuenta dos aspectos: la direccion que llevan los ejes en la pieza y
la direccion que llevara el fluido en la entrada de la pieza.

Para ello vamos al menu Process -> Gravity y aparece la siguiente ventana:
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Figura 5.27

Esta ventana esté dividida en tres apartados:

e EIl apartado Direction muestra la direccién que lleva la gravedad y permite
modificarla. Por defecto aparece la direccion Z positiva, en nuestro caso no la
modificamos.

e En el apartado Constant Gravity se muestra el valor de la gravedad. Este valor se
puede modificar, por defecto tiene el valor de -9.81m/s2. En nuestro caso
dejamos el valor por defecto.

e Por ultimo, en el apartado Option se muestra la opcion Tilt Pouring. Esta opcion
permite modificar el grado de inclinacion que tiene el molde en el momento del
llenado. En nuestro caso no activaremos esta opcion.

5.7.2 Condiciones de contorno

A continuaciéon definimos las condiciones de contorno del modelo. Estas
condiciones permiten imponer limites en el modelo virtual para que se asemeje al
modelo real.
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Existen dos tipos de condiciones de contorno: las hidraulicas y las térmicas. Las
condiciones hidraulicas hacen referencia a las condiciones del fluido y las térmicas

hacen referencia a las propiedades que tienen que ver con las temperaturas, intercambio
de calor, etc.

Para sacar la lista con las condiciones de contorno iremos al menl Process ->

Input Data Check. Aparecera en la parte izquierda del area de trabajo una lista con todas
las condiciones disponibles.

Para afiadir, modificar o eliminar una condicion, seleccionamos la condicion y le
damos al boton derecho del raton. A continuacion elegiremos la opcién que se quiera
realizar.

e Condiciones hidraulicas.
En nuestro caso vamos a introducir las siguientes condiciones: Initial Fluid,
Velocity, Permeability y Region Roughness. En todas las condiciones se puede
introducir el nombre de la condicion en el apartado Name.

o Initial fluid: esta condicién permite indicar el lugar por donde se inicia el
Ilenado.
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Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcién ADD para afiadir una
nueva condicion y aparecerd la siguiente ventana:

Marne:
IMITIAL_FLLID_1
Fluid fraction (%]

100

Condition

() Imposed ) Initial

Yolume list

Fieza
Molde

ak ] [ Cancel ] [ Help

Figura 5.29

En el apartado Fluid fraction se introduce el 100% ya que se considera
que, por el volumen entrada, pasa toda la colada en forma liquida. Luego
seleccionamos la opcion Imposed. Esta opcion permite que la entrada se
mantenga llena en todo momento. A continuacion iremos al area de
trabajo y seleccionamos la entrada con el boton izquierdo del raton.
Seleccionamos este volumen porque por ahi entra la colada.

Comprobamos que en el apartado Volume list este seleccionada la
Entrada y le damos a OK.

Velocity: esta condicion permite imponer la velocidad de llenado.

Para introducir esta condicion, seleccionamos la condicion y le damos al
botdn derecho del raton. Luego elegimos la opcién ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:

Imposed Velocity C:\PFC\.. \Pieza or... @]

M ame:
IMPOSED_VELOCITY_1
Welocity definition

I8 14 05

Region list

ExTF-Entrada

ExTF-Malde

ExTF-Pieza
a-Molde

INTF-Entrad. za
INTF-Malde-Entrada
INTF-Molde-Fieza
INTF-Pigza-Malde

Filling time : | 7.73863

Ok ] [ Cancel ] [ Help

Figura 5.30
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En el apartado Velocity se introduce la velocidad de llenado del molde en
m/s. Esta velocidad se puede definir de dos formas: si elegimos el boton

'@ tendré un valor fijo; si elegimos el boton X podemos introducir una
ecuacion, de esta manera tendra un valor variable. En nuestro caso
introducimos el valor fijo de 0.5 m/s.

A continuacion vamos al area de trabajo y seleccionamos, con el botén
izquierdo del ratdn, la parte superior de la entrada. Seleccionamos esta
region porque entrara por ahi la colada Comprobamos que en el apartado
Region list este seleccionada la opcion INTF-Entrada-Molde y le damos
a OK.

Permeability: esta condicion permite simular el escape del aire a través
del molde.

Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:

|

Name:
MOLD_PERMEABILITY_1

Permeability GF index: 120
Average mold thickness [cm]: 30

Fieqgion lizt

ExTF-Entrada
ExTF-Malde
ExTF-Pieza
INTF-Entrada-Molde
INTF-Entrada-Fieza
INTF-Molde-Entrada
INTF-Molde-Pizza
INTF-Pigza-Molde

ok ] [ Cancel ] [ Help

Figura 5.31

El apartado Permeability GF Index muestra la permeabilidad del molde
basandose en el indice de Georges Fisher. Este indice aparece por defecto
segun el material del molde. En nuestro caso dejaremos el valor por
defecto.

En el apartado Average Mold thickness se introduce el espesor medio del
molde en cm. Este espesor sera el que tiene el molde con respecto a la
pieza, eligiendo para nuestro caso el valor de 30 cm.

A continuacion, en el area de trabajo seleccionamos la parte exterior de
la pieza porque en esta region se produce el intercambio de gases entra la
cavidad y el molde, es decir, en el apartado Region List seleccionamos
EXTF-Pieza y le damos a OK.

Region Roughness: esta condicion permite simular la rugosidad que hay
en el interior del molde.
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Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecerd la siguiente ventana:

M ame:
REGION_ROUGHMESS_1

Roughness Index:
0.05

Fiegian list

EXTF-Entrada
EXTF-Molde

IMTF-Entrada-Malde
INTF-Entrada-Fieza
IMTF-Muolde-Entrada
IMTF-Molde-Pieza
INTF-Pieza-Molde

ak ] [ Cancel ] [ Help

Figura 5.32

En el apartado Roughness Index se muestra el valor de la rugosidad del
molde. Este valor aparece por defecto dependiendo del material del
molde que elijamos.
A continuacion vamos al area de trabajo y seleccionamos la parte exterior
de la pieza porque es en esta region donde la rugosidad del molde afecta
al proceso de llenado, es decir, en el apartado Region List estara
seleccionada la opcién EXTF-Pieza y le damos a OK.
e Condiciones térmicas

En nuestro caso vamos a introducir las siguientes condiciones: Temperature,

External Exchange y Contact Resistance. En todas las condiciones se puede

introducir el nombre de la condicion en el apartado Name.

o Temperature: esta condicion permite indicar la temperatura que va a
tener el material fundido en el volumen entrada.
Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:
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Figura 5.33

En el apartado Condition elegimos la opcion Imposed. De esta forma se
mantendra esa temperatura durante toda la etapa que elijamos.

El apartado Temperature definition muestra el valor de la temperatura.
Esta temperatura se puede definir de dos formas: si elegimos el botén o)

tendra un valor fijo; si elegimos el botén & podemos introducir una
ecuacion, de esta manera tendra un valor variable. Esta temperatura, por
defecto, tiene un valor que viene definido por el material de la aleacion.
En nuestro caso dejamos el valor por defecto.

En el apartado Applies to activamos solo la opcion Filling ya que,
queremos aplicar esa temperatura solo durante el proceso de llenado.

A continuacion, y dado que el éarea de trabajo es la entrada,
comprobamos que en el apartado Object, esta seleccionada la opcién
Entrada, y le damos a OK.

External Exchange: esta condicién permite indicar la transferencia de
calor que se produce entre el molde y el exterior.

Para introducir esta condicion, seleccionamos la condicion y le damos al
botdn derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:
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Figura 5.34

En el apartado External Temperature se muestra el valor en °C de la
temperatura exterior. En nuestro caso elegimos el valor de 20°C.

En Material Emissivity se muestra el valor del coeficiente de emisividad
que tiene el material del molde con el exterior. Este coeficiente es un
numero adimensional. El valor de la emisividad, por defecto, viene dado
por el material del molde. En nuestro caso dejamos el valor por defecto.
En el apartado Applies to activamos la opcion Filling y Solidification ya
que, el intercambio de calor afecta a las dos etapas.

En el apartado Type of Exchange se puede elegir el tipo de intercambio
que se tiene en cuenta. En nuestro caso elegimos la opcién Radiation and
Convection puesto gue se producen ambos tipos en nuestra pieza.

Por ultimo, seleccionamos la region exterior del molde, es decir, en
Region List tiene que estar seleccionada EXFT-Molde. Le damos a OK.
Contact Resistance: esta condicién se utiliza para imponer la resistencia
térmica que se produce por estar en contacto una region.

Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:
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Figura 5.35

En el apartado Resistance or HTC permite elegir el tipo de contacto que
se produce. Dependiendo de la opcion elegida las unidades varian. Estas
unidades aparecen en cada apartado.

En nuestro caso, elegimos la opcion Resistance ya que el intercambio de
calor se produce por una resistencia térmica. El valor que se muestra
viene dado por defecto dependiendo del material de la pieza. Este valor

se puede definir de dos formas: si elegimos el botén /& tendré un valor

fijo; si elegimos el boton k& podemos introducir una ecuacion, de esta
manera tendrd un valor variable. En nuestro caso dejamos el valor por
defecto.

En el apartado Applies to activamos solo la opcion Filling ya que,
queremos aplicar esa condicion solo durante el proceso de llenado.

A continuacion vamos al area de trabajo y seleccionamos la pieza.
Comprobamos que en el apartado Regions esté seleccionada la opcion
EXFT-Pieza y le damos a OK.

5.8 Célculos de resultados

A continuacién iniciamos los calculos de los resultados. Para ello iremos al
menu Standard Calculation -> Calculation Start y aparece la siguiente ventana:
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Figura 5.36

En esta ventana elegimos la pestafia Filling and Solidification puesto que
queremos obtener los calculos para el llenado y la salificacion. Esta ventana muestra los
siguientes apartados:

e Calculation type: permite elegir el método de célculo y las temperaturas iniciales.
En nuestro caso elegimos la opcién Standard calculation. Introducimos el valor
20°C tanto para el molde como para la cavidad del molde.

e Stop Filling Criteria: sirve para definir los parametros de parada para los
calculos de llenado. Los célculos se paran cuando hayamos sobrepasado el
tiempo de llenado o cuando sobrepasemos el porcentaje de llenado que
previamente hemos introducido en este panel. En nuestro caso dejamos los
valores por defecto.

e Stop Solidification Criteria: sirve para definir los parametros de parada para los
calculos de solidificacion. Los calculos se paran cuando sobrepasemos el tiempo
se solidificacion o la temperatura sea inferior a la que previamente hemos
introducido en este panel. En nuestro caso dejamos por defecto el valor del
tiempo méaximo. Solo se cambia la temperatura méxima a 200 °C.

e Options: en este aparatado seleccionamos la opcion None ya que se trabaja en
una fundicion por gravedad.

En el resto de apartados dejamos las opciones que vienen por defecto.

Una vez que ya hemos introducido todos los parametros le damos al boton Run.
A continuacion QuikCast empezard a realizar los calculos. Aparecerd la siguiente
ventana que indicara los progresos que llevan los calculos para cada proceso.
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Figura 5.37

Una vez que los célculos han terminado aparece un mensaje indicando que han
finalizado. El programa creara un archivo de resultados donde solo aparecen los
resultados. Este archivo mantiene el mismo nombre del estudio pero tiene la extension

AN s

.mco

5.9 Resultados

Una vez que se han completado los calculos tanto de llenado como de
solidificacion el dltimo paso es ver los resultados.

Para ello, abrimos el archivo de resultados creado por el programa. Para ello vamos al
menu File -> Open y seleccionamos el archivo con extension “.mco”. El programa crea
el archivo con el mismo nombre que el estudio. Aparece una ventana donde elegimos
los volumenes que queremos abrir. Para ello seleccionamos la pieza y la entrada y
dejamos marcada la opcion Use Smoothing Mesh. Si no marcamos esta opcion la pieza
se abrira con la forma de la malla.
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Figura 5.38

Una vez que hemos abierto el archivo iremos al menu results. Ahora en este
menu ya estan disponibles todas las formas de ver los resultados.

Si vamos al menu results -> Mesh Correction Factors... aparecera una ventana
(ver figura 5.39) en la que eligiendo la opcion volumen, muestra el porcentaje de
aleacion que tiene cada celda de la malla de volumen que habiamos creado.

Mesh Correction... |Z||E|g|
Object Tupe

) Region

=) Volume
() Disconnected Elements ’
() Aspect ratio

[ Drizplay ][ Cloge ][ Help ]

Figura 5.39
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Figura 5.40

Si vamos al menu el Filling / Solidification aparece una ventana que permite ver
las distintas etapas de los procesos de llenado y de solidificacion de la pieza. En la
opcidn Type seleccionamos el proceso que queremos ver; en Results Type elegimos la
variable a analizar; y si se encuentra activada la opcion de Show Liquid, se pueden ver
las zonas con liquido. Se pueden activar o desactivar en funcion de los procesos que se
quieran ver.

Filling f Solidification C:\PFC\.. \Prueba.mco (2 ][E1/X]

Simulation Results

Type: |Filing + | [¥] show Liguid E] ﬂ
Fillirg
Results Type: |spfdification =]
Selection States [ Time
single Stake MHEEE Stabe 0 0.000000 ~

State 1: 0.508250
State 2 1.013006

Select:
Increment: ﬂ ﬂ State 3: 1.517262
State 4 2021266

State 5@ 2.536736
J J J J J State 6@ 3.040724
State 7@ 3.544735
State & 4.048754

State 9 4.564357
State 10 5.068615 b

[Update] [ Close ] [ Help ]

Figura 5.41
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Si elegimos el proceso de llenado (Filling) tenemos las siguientes opciones:

e Fill Rate: muestra el llenado de la pieza.

e Temperature: muestra la temperatura durante el llenado.

e Pressure: muestra la presion en la pieza durante el llenado.

e Velocity: muestra la velocidad del flujo durante el llenado.

o Fill time: muestra que partes se han llenado durante un determinado tiempo.

Si elegimos el proceso de solidificacion (Solidification) tenemos las siguientes
opciones:

e Liquid Fraction: muestra la parte liquida que hay en la pieza.

e Temperature: muestra la temperatura durante la solidificacion.
¢ Shrinkage: muestra la contraccion que se producen en la pieza.
e Solid Fraction: nos muestra la parte solida que hay en la pieza.

Para ver los resultados, podemos ir fijando en cada una de las etapas
seleccionado la etapa que queremos ver en la lista de la derecha. También podemos
seleccionarla todas y con la opcion multiple state y dandole al boton generate movies
podemos verlo en forma de video. Si queremos guardar el video activaremos la opcion
create an AVI File. Hacemos clic en generate.

Path to store

C:APFCA.. MDD B

I Generate I [Stop Generation]

Figura 5.42

Si vamos al siguiente menu results -> process Sypnosis aparecera la siguiente
ventana:

Process Synopsis ...\pieza entrada d... E|§|E|

Frocess Results

Type: |[WEE w | Shyle: | Banded Contours b

Specific Calculation:

Shrinkage W @

Threzshold value [Z] |1

Figura 5.43
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En esta pantalla se puede elegir los resultados que queremos analizar:

Defects: muestra los resultados relacionados con los calculos de prediccién de
defecto.

©)

Shrinkage: proporciona informacion sobre la contraccion en la aleacion.
Se observa las contracciones que sufre la pieza cuando ya se ha
solidificado (ver figura 5.44).

v0/Pieza1  Shrinkage

1.00e+002

9.33e+001

8.67e+001

8.00e+001

7.33e+001

6.67e+001

6.00e+001

5.33e+001

4.67e¢+001

4.00e+001

3.33e¢+001

2.67e+001

2.00e+001

1.33e+001

6.67e+000

0.00e+000

Figura 5.43

Dendritic Arm Spacing: informa sobre la micro estructura de la aleacion.
Niyama Criterion: calcula segun el criterio de Niyama. Informa sobre la
porosidad de la aleacion.

Solidifiction Rate: calcula la velocidad de enfriamiento.

Volume Fraction of Gas Porosity: proporciona informacion acerca de la
micro porosidad del gas

Solidification: muestra los resultados con el final de los célculos de la
solidificacion.

o

Time to Solidus: proporciona el tiempo que necesita la aleacion para
alcanzar la temperatura de solido

End of Calculation temperature: proporciona informacion sobre la
temperatura el final de los calculos.

Time to Critical Solid Fraction: proporciona el tiempo que necesita la
aleacion para alcanzar el valor critico de la fraccion solida.

Time to Eutectic Temperature: tiempo que tarda la aleacion en alcanzar
la temperatura eutéctica.
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o Temperature Gradient at Eutectic Temperature: informa sobre los
gradientes termicos en la aleacion a la temperatura eutéctica.

o Temperature Gradient at Solidus — Degrees Celsius: informa sobre los
gradientes térmicos en la aleacion en la fase sélida.

o Local Cooling Rate: informa sobre la velocidad de enfriamiento

o Solidification Time: muestra el tiempo de solidificacion.
En esta opcion se muestra de forma grafica cuanto tiempo tarda en
solidificase cada zona de la pieza (ver figura 5.44).

Pieza1l  Solidification Time (s)

1.57e+002

1.46e+002

1.36e+002

1.25e+002

1.15¢+002

1.05e+002

9.41e+001

8.36e+001

7.32e+001

6.27e+001

5.23e+001

4.18e+001

3.14e+001

2.09e+001

1.05e+001

0.00e+000

Figura 5.44

En la opcion Style podemos cambiar la forma de visualizar los resultados de la
pieza.
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Capitulo 6: Guion alumno

6.1 Creacion de un nuevo estudio

Abrimos el programa QuikCast y creamos un nuevo estudio. Para ello vamos al

menU File -> New o iremos al icono = en la barra de herramientas, apareciendo la
siguiente ventana:

Study

Mame: |Pieza1 |

WVerzion Mame; |v|:| |

Location: |I2:\F'FI:'\F'ara entregar | E

Impart PHF File

| O

Figura 6.1

En el apartado Name introducimos el nombre que se quiera dar al estudio. A
continuacién vamos al apartado Location y hacemos clic en el botén [ para elegir la
ubicacién donde se guarda el estudio. Hacemos clic en Ok.

A continuacion se abre una ventana donde buscamos el archivo de disefio. Luego
hacemos clic en Open para abrir la pieza en el area de trabajo. Apareciendo ahora otra
ventana donde se eligen las opciones de importacién del archivo.

Import File options C:\... le
Cal Units System

Impart File :
Welding
On/off
Taolerance [rmm) : | 0.007
tezh Repair

Automatic Mesh Fixing

[ 0k ] [Eancel] [ Help ]

Figura 6.2
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En los apartados Import File y Lengh se elige Metric y Milimeter
respectivamente.

A continuacion activamos la opcion Automatic Mesh Fixing. Para terminar
hacemos clic en Ok. Luego aparece una ventana que indica los errores que se han
encontrado en la geometria de la pieza. Para reparar los errores automéaticamente
hacemos clic en Yes.

Automatic Mesh Fixing Res...

“Para entregar'Flanos\Pieza original.stl

0 Coplanar ¥
@ 0 Free edge ]
B rssmalse ¢

‘Warning : too much errors [ > 600]
Automatic Mesh Fixing can be too long

Do you want to perform
1 E Automatic Mesh Fizing 7
-

Figura 6.3

Ahora ya se puede observar que la pieza se ha abierto en el area de trabajo.

Figura 6.4
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6.2 Creacion de la entrada

Para crear la entrada hay que ir al mend Model -> Mesh Basic Shapes -> Inlet o
ir directamente al icono!_|. Aparece la siguiente ventana:

Create Inlet, C:\PFC\...\Pieza original stl

Shape name

|Sha|:|e_name |

Shape [mm]
(%) Cylinder ) Parallelepiped

Diameter:

Height: |5

Lozation [mm)
~
] Reverze arentation Connected region mesh

Figura 6.5

En esta ventana tenemos las opciones geométricas y de ubicacién de la entrada.
Vamos al apartado Shape y elegimos la opcidn Cylinder. En este apartado introducimos
las siguientes dimensiones:

o Diametro=8 mm
o Altura=5 mm

A continuacion definimos las coordenadas de
la ubicacion de la entrada en el apartado
Location. Para colocar la entrada pinchamos
en la parte superior del bebedero y, a
continuacion introducimos las siguientes
coordenadas:

X=58

Y=50
Figura 6.6 Z=65.

Luego tenemos que activar la casilla Connected region mesh. Para terminar
pulsamos en el boton Apply.
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6.3 Creacion del molde
Para crear el molde vamos al mend Model -> Mesh Basic Shapes -> Mold o

hacemos clic en el icono ™ . A continuacion aparece la siguiente ventana:

o ld Pieza completa o

Corners lacation Madel Origin [ mm )

Finirimum M aximum
LN | J xmo
cmn|x g - 3 xfEe v
SN | SV

Figura 6.7

Las dimensiones de nuestro molde van a ser 140x150x150 mm. Para definir el
molde en QuikCast hay que introducir la distancia de la base, la tapa y las caras respecto
al origen de coordenadas de la pieza. Por ello introducimos las dimensiones que
aparecen en la Figura 6.7. Hacemos clic en Apply y el programa crea el molde.

6.4 Creacion de los volumenes

A continuacién creamos los volimenes. Para ello iremos al mend Model ->
Domains Manager. Aparecera la siguiente ventana:

Domains Manager C:\PFC\...\Pieza original.stl

Wolumes ‘ Fiegions | Air Wenting Regions
Wolumes Awailable Regions
91 Yiew Yolume || View Mext Valume Pricrity %j_ @
Name Material Type SurfaceDomain_1 Mew
F COPLANAR_FIXED1
shape_name_BOTTOM Fename
= shape_name_CORE
shape_name_TOP Remove
- MOLD_SURFACE_1
Update
b aterial
=
|
Automatic volume detection Material Interface
Connected region mesh OYes @MNo
[[] Create contact region
[ ] |Compute volume [ onsit
Status
“ Yolumes

Figura 6.8
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Lo primero que haremos es ir a la opcion Connected Regions Mesh y seleccionar
la opcion No. A continuacion activamos la casilla Create Contact Region en el apartado

Automatic volume detection y luego hacemos clic en el boton|-2mP e ¥alume . nara crear
los volimenes automaticamente.

Una vez que se han creado aparece una ventana emergente. En esta ventana
seleccionamos la opcion Remove.

Remove or Keep

Do you want to remowe or to keep the regions created before ?

[ Remove |[ Keep

Figura 6.9

Ahora, en el apartado Volumes aparecen los volimenes que se han creado. Se
pueden observar tres volumenes que pertenecen a la entrada, la pieza y al molde. Para
visualizar si estan bien los volimenes, utilizamos los botones situados encima de la lista
de volumenes. Si se hace clic en cualquier volumen se observan las regiones que
conforman el volumen ya que aparecen sombreados en la lista de regiones. El volumen
1 es la entrada (Figura 6.10), el volumen 2 es la pieza (Figura 6.11) y el volumen 3 es
el molde (Figura 6.12).

Figura 6.10 Figura 6.11
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Domains Manager C:\WPFC\...\Pieza original.stl

Volumes | Fregions || Ait Venting Regions|
Volumes
51 View Next Voume
il

Name
YOLUME 001

VOLUME_ D02 Nore
VOLOME 003 None

Type

Automatic volume detection Material Intertace

Connected region mesh OYes @No

Create contast region D

Automatic volume detection finished

(ARRAARARRAAARARRRRRRRARRER) |Computs vohume Clonaf

o Volumes

Figura 6.12

En este caso el programa crea tres volimenes. A continuacién renombramos los
volumenes para poder distinguir los diferentes volimenes. Para ello seleccionamos el
volumen y hacemos clic en el boton Rename. Aparece una ventana donde escribimos el

nuevo nombre.

Rename Volume

MName: |Entrada

Figura 6.13

Los nombres que introducimos en los volimenes son los siguientes:
Volumen_001= Entrada;
Volume_002= Pieza;

Volume_003 3= Molde.

El siguiente paso es asignar el material para cada volumen. Para ello se
selecciona el volumen Molde y haciendo clic en Material y aparece la siguiente ventana:
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X

Material Yolume

Walurie[z)
MName : | Molde |

Yolume Type ;| (S w

FPhysical Properties
() Standard database

() User database

Materials List: | GREEN_SAND |
[ 0K ] [Eancel]
Figura 6.14

En el apartado Volume Type seleccionamos la opcion Mold. A continuacion
elegimos el material del molde en la lista Material List. En nuestro caso elegimos
GREEN_SAND. Luego hacemos clic en Ok.

Para seleccionar el material de la pieza se selecciona el volumen Entrada (Figura
6.15). En el apartado Volume Type elegimos Alloy. Luego, en Material List, eligemos el
material AISi7Mg y hacemos clic en Ok. A continuacion aparecera un mensaje (Figura
6.16) que nos informa que va a asignar el mismo material al resto de volimenes.

Material Yolume

Walunie[z]

Marne : |

Vaolume Type |A|In_|,|

Physzical Properties
(%) Standard database

(") User databaze

M atenials List: | AlSi7Ma

Lok

’ Cancel ]

Figura 6.15

X

|
v

QuikCAST 2011
|
L] 'j &ll alloy volumes tvpe set to @ &lSi7Mg
W | -
Figura 6.16

Por altimo ordenamos los volumenes por orden de llenado, dejando al final los
volimenes pertenecientes al molde (Figura 6.17). En este caso se ordena de la siguiente
manera: entrada, pieza y molde.
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Yalumes

g ["v"iew Walume ] [ Wiew Mest Volume Pricrity
M ame k atenal Type I?
Entrada AlSiTMog Allay
Pieza £1577Ma Alloy ﬂ
blolde GREEM_SAMD b old

Figura 6.17

Comprobamos en el panel de Status (Figura 6.18) que, los volumenes y los
materiales, se encuentren con un tic verde. Esto nos indica que ambos se han realizado
de forma correcta.

Wohumeat v M sl

Figura 6.18

6.5 Generacion de la malla

A continuacion generamos la malla de la pieza. Para ello vamos al mend Model -
> 3D Grid/Mesh Generation y aparece la siguiente ventana:
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3D Mesh Generation C:\PFC\...\Pieza o...

Auta Create | Modify || Insert || Delete
Grid
) Uniform (O Advanced

-
Select Walume =g=|

Average Size: 0.005
Max Size: 0oz
M ax Growth B ate: 11
Min Size: 0.001

Apply Restore Initial Grid

Gnd Information

Mumber of Cells : 1
2D Ratio criteria OK

9

tMezh Generation

v

025

Cloze ] [ Help ]

Figura 6.19

En esta ventana elegimos la pestafia Auto. Luego iremos al apartado Grid y
seleccionamos la opcion Uniform. A continuaciébn comprobamos que, en Select
volumen, solo estén seleccionados los volumenes Pieza y Entrada. A continuacién
dejamos los valores que aparecen por defecto en las siguientes casillas: Average Size,
Max Size, Max Growth Rate y Min Size.

Luego le damos al boton Apply. Si se ha realizado de forma correcta, en el
apartado Numbers of Cells(Figura 6.20) aparecera: el nimero de celdas en los que va a
dividir a las piezas y un tic verde.

Gnid Information
Mumber of Cells : 21952
20 Ratio criteria OF,

J

Figura 6.20
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A continuacion vamos al apartado Mesh Generation (Figura 6.21) y le damos al
botdn Run para generar la malla. Una vez terminada, aparece Mesh completed y la barra
en color verde con un porcentaje al 100%. Para finalizar le damos a Close.

Meszh Generation
tezh completed

v

Figura 6.21
6.6 Imposicion de las condiciones de contorno

6.6.1 Gravedad
El primer punto en las condiciones de contorno, es comprobar la direccion que

Ileva la gravedad. En nuestro caso es importante este apartado puesto que realizamos un
llenado por gravedad

Para ello vamos al menu Process -> Gravity y aparece la siguiente ventana:

Gravity C:\PFC}. . \Pieza original.stl E]

Diirection Constant Gravity
Positive 2w -9.81
Option
I Tilk pouring
I [0].4 ] [ Default] [Cancel] [ Help ]
Figura 6.22

Vamos al apartado Direction y elegimos la direccion Positive Z. Luego iremos al
apartado Constant Gravity y comprobamos que el valor de la gravedad sea -9.81 m/s.
Para terminar le damos a Ok.

6.6.2 Condiciones de contorno

A continuaciéon definimos las condiciones de contorno del modelo. Estas
condiciones permiten imponer limites en el modelo virtual para que se asemeje al
modelo real.
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<& QuikCAST 2011 - [Pre-Processing Project [Pieza completa ok 1] Version[v0] - C:\PFC\Geovanny_Alberto\Pruebas\Pruebalv]

€5 Fle Edit View Model Material Database Process Standard Calculation Advanced Caleulation Resuks Tools Options Window Help
EE B B T E|[veter | @
LENEL

-8 x

=/ Hydraulic Conditions
Initial Fluid

Air Gap

Contact Resistance
Cooling

Die Spray

Mold Opering

Third stage effect

Select o deselect an abject. (Modfiers: Shift=Extends Selection)

Figura 6.23
Existen dos tipos de condiciones de contorno: las hidraulicas y las térmicas.
Las condiciones hidraulicas hacen referencia a las condiciones del fluido.

Las condiciones térmicas hacen referencia a las propiedades que tienen que ver
con las temperaturas, intercambio de calor, etc.

Para sacar la lista con las condiciones de contorno iremos al mend Process ->
Input Data Check. Aparecera en la parte izquierda del area de trabajo una lista con todas
las condiciones disponibles.

e Condiciones hidraulicas
En nuestro caso vamos a introducir las siguientes condiciones: Initial Fluid,
Velocity, Permeability y Region Roughness.
En todas las condiciones se puede introducir el nombre de la condicién en el
apartado Name. En nuestro caso no modificamos el nombre a ninguna condicion.

o Initial fluid: esta condicién permite indicar el lugar por donde se inicia el
Ilenado.

Para introducir esta condicién, seleccionamos la condicion y le damos al
botén derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:
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p x|
Name:

IMITIAL_FLUID_1

Fluid fraction (%)

100

Condition

() Imposed O Initial
Wolume ligt

HEIEE

Pieza
Malde

[ akK. ] [ Cancel ] [ Help

Figura 6.24

En el apartado Fluid fraction introducimos el valor 100. Luego
seleccionamos la opcion Imposed. A continuacién vamos al area de trabajo y
seleccionamos la entrada con el boton izquierdo del ratén. Comprobamos
que en el apartado Volume list este seleccionada la Entrada y le damos a OK.

o Velocity: esta condicion permite imponer la velocidad de llenado.

Para introducir esta condicidon, seleccionamos la condicion y le damos al
botdn derecho del raton. Luego elegimos la opcién ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:

Imposed Velocity C:WPECA.. .\Pieza or... EJ

Mame:
IMPOSED_VELOCITY_1
Welocity definition
|& 1| [os
Region list

EXTF-Entrada
EXTF-Molde

INTF-Entrada-Fieza
INTF-Molde-Entrada
INTF-Molde-Pieza
INTF-Pieza-Malde

Filing time : | 7.73863

Ok ] [ Cancel ] [ Help

Figura 6.25

En el apartado Velocity introducimos el valor 0.5 m/s. A continuacién
vamos al area de trabajo y seleccionamos, con el botén izquierdo del
raton, la parte superior de la entrada. Comprobamos que en el apartado

Region list este seleccionada la opcion INTF-Entrada-Molde y le damos
a OK.
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o Permeability: esta condicion permite simular el escape del aire a través
del molde.
Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecerd la siguiente ventana:

[ x|
M arme:
MOLD_PERMEABILITY_1

Permeability GF index: 120
Average mold thickness [cm): 30
Fegion list
== ==
EXTF-Entrada
EXTF-Molde

EXTF-Fieza
INTF-Entrada-tMolde

INTF-Entrada-Fieza
INTF-Malde-Ertrada
IMTF-Molde-Fieza
INTF-Pigza-Molde

QK ] [ Cancel ] [ Help

Figura 6.26

En el apartado Permeability GF Index dejaremos el valor que aparece
por defecto.

A continuacion vamos al apartado Average Mold thickness e
introducimos el valor de 30 cm.

Luego vamos al area de trabajo y seleccionamos la parte exterior de la
pieza. Para finalizar comprobamos que, en el apartado Region List, esta
seleccionada la opcion EXTF-Pieza y le damos a OK.

o Region Roughness: esta condicion permite simular la rugosidad que hay
en el interior del molde.
Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:
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MHame:
REGION_ROUGHWESS 1

Roughness Indes:
0.0s

Fieqion lizt

E=TF-Entrada
ExTF-tMalde

IMTF-Entrada-tdolde
IMTF-Entrada-Fieza
IMTF-Malde-Entrada
IMTF-Molde-Pieza
IMTF-Pieza-tolde

0k l [ Cancel l [ Help

Figura 6.27

En el apartado Roughness Index dejamos el valor que aparece por defecto
A continuacion vamos al area de trabajo y seleccionamos, con el botdn
derecho del ratdn, la parte exterior de la pieza. Comprobamos que en el
apartado Region List este seleccionada la opcion EXTF-Pieza y le damos
a OK.

Condiciones térmicas

En nuestro caso vamos a introducir las siguientes condiciones: Temperature,
External Exchange y Contact Resistance.

En todas las condiciones se puede introducir el nombre de la condicién en el
apartado Name. En nuestro caso no modificamos el nombre a ninguna condicion.

o Temperature: esta condicion permite indicar la temperatura que va a
tener la entrada.
Para introducir esta condicion, seleccionamos la condicion y le damos al
botdn derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:
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Mare:
TEMPERATURE_1

Condition

® Imposed O Iiial
Temperature definition

(& @ 720

Applies ta

Filing [ Solidification
Dbject

AS  [zges

Fieza
Iolde

QK ] [ Cancel ] [ Help

Figura 6.28

En el apartado Condition elegimos la opcion Imposed. A continuacion,
en el apartado Temperature definition, dejamos el valor que aparece por
defecto. Luego vamos al apartado Applies to y activamos solo la opcion
Filling. A continuacién vamos al area de trabajo y seleccionamos, con el
boton derecho del ratén, la entrada. Por ultimo comprobamos que, en el
apartado Object, este seleccionada la opcion Entrada y le damos a OK.

External Exchange: esta condicion permite indicar la transferencia de
calor que se produce entre el molde y el exterior.

Para introducir esta condicion, seleccionamos la condicion y le damos al
boton derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:

Name:
EXTERMAL_ExCHANGE_1

External Temperature
0 | L4 (20
b aterial Emiszivity

W af o:

Applies o
Filling Salidification

Type of Exchange
(%) Radiation and Convection () Radiation Orly

Fiegion list

ExTF-Entrada
EXTF-Molde
EXTF-Pieza
INTF-Entrada-Molde
INTF-Entrada-Pizza
INTF-Molde-Entrada
INTF-Molde-Fieza
INTF-Pieza-Molde

[ ag ] [ Cancel ] [ Help

Figura 6.29
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Vamos al apartado External Temperature e introducimos el valor de 20°C.
En el apartado Material Emissivity dejamos el valor que aparece por
defecto.

A continuacién iremos al apartado Applies to y activamos la opcion
Filling y Solidification.

Luego vamos al apartado Type of Exchange y elegimos la opcién
Radiation and Convection. A continuacién vamos al area de trabajo vy,
con el boton izquierdo del ratén, seleccionamos el molde. Comprobamos
que, en el apartado Region List, este seleccionada la opcion EXFT-Molde
y le damos a OK.

Contact Resistance: esta condicién se utiliza para imponer la resistencia
térmica que se produce por estar en contacto una region.

Para introducir esta condicidon, seleccionamos la condicion y le damos al
botén derecho del raton. Luego elegimos la opcion ADD para afiadir una
nueva condicion y aparecera la siguiente ventana:

E B
Narme:
CONTACT_RESISTANCE_1

Resistance or HTC

(%) Resistance (e () HTC [wWi/mek)

@@J 0.0001

Applies to
Filling [ Solidification

Fegions
===

ExTF-Entrada
EXTF-Malde
ExTF-Pieza
INTF-Entrada-tolde
INTF-Entrada-Pieza
INTF-Molde-Entrada

INTF-Molde-Fieza
INTF-Fieza-talds

oK ] [ Cancel ] [ Help

Figura 6.30

Vamos al apartado Resistance or HTC y elegimos la opcidn Resistance.
En nuestro caso dejamos el valor que aparece por defecto.
Luego iremos al apartado Applies to y activamos solo la opcién Filling .
A continuacién vamos al area de trabajo y, con el boton izquierdo del
raton, seleccionamos la pieza. Comprobamos que en el apartado Regions
este seleccionada la opcion EXFT-Pieza y le damos a OK.
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6.7 Calculos de resultados

A continuacion iniciamos los calculos de los resultados. Para ello iremos al

menu Standard Calculation -> Calculation Start y aparece la siguiente ventana:

Calculation Start C:\PEC). .. \Pieza original.stl E]

Filling Solidification
Filling and Solidification Cyecling Advanced Porosity

Calculation type

() Standard calculation
Initial cavity temperature ["C] 20

Initial mold temperature [*C): 20
) Start fram mald thermal field
O Resume from filing
) Resume filling from solidification

Stop Filing Criteria
b aximum time (5): 1]

Percent of cavity filed

Stop Solidification Criteria

b aximum time (5): 10000
Max temperature [*C): 200
Optlions

& None ) High Pressure

Frocessors
Number of Processors 12

Fost-Treatment
[ &dvanced Porosity Calculation

[Checkdala] [ Save I [ Run
Figura 6.31

En esta ventana elegimos la pestafia Filling and Solidification puesto que
queremos obtener los calculos para el llenado y la solidificacion. Luego vamos al
apartado Calculation type y elegimos la opcidn Standard calculation. A continuacién
introducimos el valor 20°C tanto para el molde como para la cavidad del molde. Luego
vamos al apartado Stop Solidification Criteria. En este apartado dejamos por defecto el
valor del tiempo maximo y cambiamos la temperatura méaxima a 200 °C.

En el resto de apartados dejamos las opciones que vienen por defecto.
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Una vez que ya hemos introducido todos los parametros le damos al boton Run.
A continuacion QuikCast empezara a realizar los célculos. Aparecerd la siguiente
ventana que indicara los progresos que llevan los céalculos para cada proceso.

Calculation Monitor... C:\PFCA...... @|§|E|

Study
Lacation : C:APFC\Para entregar
Project : Piezal

“Wersion : vl

Filling and Salidification

Percent Filed 17.00% D
Solid Fraction 0.00% O
Simulated Time 1.31s

Advanced Porosity

Progress 0.00% D

Summary

Filling Calculation

Filling Run submitted on ;. Tue Feb 19 11:14:40 2013
Running on: 1 Processors

Step Mumber ; 152

Simulated Time : 1.31/80.00s

Time Step : 0.011558 ¢

Elapsed Time: 20 =

[> Caleulation is running

[ Stop ] [StopandSaveFlestalt Files] [ Close ]

Figura 6.32

Una vez que los célculos han terminado aparece un mensaje indicando que han
finalizado. El programa creara un archivo de resultados donde solo aparecen los
resultados. Este archivo mantiene el mismo nombre del estudio pero tiene la extension

AN rr

.mco
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6.8 Resultados

Una vez que se han completado los célculos tanto de llenado como de
solidificacion lo siguiente que se hace es ver los resultados.

Para ver los resultados tenemos que abrir el archivo de resultados que nos ha
creado el programa. Para ello vamos al menud File -> Open y seleccionamos el archivo
con extension “.mco”. El programa crea el archivo con el mismo nombre que el estudio.
Aparece una ventana donde elegimos los volumenes que queremos abrir. Para ello
seleccionamos la pieza y la entrada y dejamos marcada la opcion Use Smoothing Mesh.
Si no marcamos esta opcion la pieza se abrira con la forma de la malla.

Study Yersions

CAPFChGeovanny_Albertah,.

Wersions Available Yolumes

[#] Uze Smoathing Mesh I QK HEanceI ][ Help ]

Figura 6.33

Una vez que hemos abierto el archivo iremos al menu results. Ahora en este
menU ya estan disponibles todas las formas de ver los resultados.

Si vamos al menu results -> Mesh Correction Factors... aparecera la siguiente
ventana:

Mesh Correction... g|§|g|

Object Type
(") Region

(=) Wolume
() Disconnected Elements ’
() Azpect ratio

[ Digplay l[ Close ” Help ]

Figura 6.34
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Eligiendo la opcién volume nos muestra el porcentaje de aleacion que tiene cada
celda de la malla de volumen que habiamos creado.

Figura 6.35

Si vamos al menu el Filling / Solidification aparece una ventana que permite ver
las distintas etapas de los procesos de llenado y de solidificacion de la pieza. En la
opcidn Type seleccionamos el proceso que queremos ver; en Results Type elegimos la
variable a analizar; y si se encuentra activada la opcién de Show Liquid, se pueden ver
las zonas con liquido. Se pueden activar o desactivar en funcién de los procesos que se
quieran ver.

Filling f Solidification C:\PFC\.. \Prueba.mco (2 ][E1/X]

Simulation Results

Type: |Filing + | [¥] show Liguid E] ﬂ
Filling
Results Type! |Salidification L=

Selection States [ Time

single Stake MHEEE Stabe 0 0.000000 ~
State 1: 0.508250
State 2@ 1.013006

Select:
Increment: ﬂ ﬂ State 3: 1.517262
State 4 2021266

State 5@ 2.536736
J J J J J State 6@ 3.040724
State 7@ 3.544735
State & 4.048754

Skate 9 4.564357
State 10 ¢ 5.068615 v

[Update] [ Close ] [ Help ]

Figura 6.36
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Si elegimos el proceso de llenado (Filling) tenemos las siguientes opciones:

e Fill Rate: muestra el llenado de la pieza.

e Temperature: muestra la temperatura durante el llenado.

e Pressure: muestra la presion en la pieza durante el llenado.

e Velocity: muestra la velocidad del flujo durante el llenado.

o Fill time: muestra que partes se han llenado durante un determinado tiempo.

Si elegimos el proceso de solidificacion (Solidification) tenemos las siguientes
opciones:

e Liquid Fraction: muestra la parte liquida que hay en la pieza.

e Temperature: muestra la temperatura durante la solidificacion.
¢ Shrinkage: muestra la contraccion que se producen en la pieza.
e Solid Fraction: nos muestra la parte solida que hay en la pieza.

Para ver los resultados, podemos ir fijando en cada una de las etapas
seleccionado la etapa que queremos ver en la lista que hay a la derecha. También
podemos seleccionarla todas y con la opcién multiple state y dandole al boton generate
movies podemos verlo en forma de video. Si queremos guardar el video activaremos la
opcidn create an AVI File. Hacemos clic en generate.

Path to store

C:APFCA.. MDD B

I Generate I [Stop Generation]

Figura 6.37

Si vamos al siguiente menu results -> process Sypnosis aparecera la siguiente
ventana:

Process Synopsis ...\pieza entrada d... E|§|E|

Frocess Results

Type: B w | Shle: | Banded Contours v

Specific Calculation:

Shrinkage w @

Threzhold value [Z] |1

Figura 6.38
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En esta pantalla se puede elegir los resultados que queremos analizar:

- Defects: muestra los resultados relacionados con los calculos de prediccion de
defecto.

©)
©)
©)

Shrinkage: proporciona informacion sobre la contraccion en la aleacion.
Dendritic Arm Spacing: informa sobre la micro estructura de la aleacion.
Niyama Criterion: calcula segun el criterio de Niyama. Informa sobre la
porosidad de la aleacion.

Solidifiction Rate: calcula la velocidad de enfriamiento.

Volume Fraction of Gas Porosity: proporciona informacién acerca de la
micro porosidad del gas

- Solidification: muestra los resultados con el final de los calculos de la
solidificacion.

o

Time to Solidus: proporciona el tiempo que necesita la aleacion para
alcanzar la temperatura de solido

End of Calculation temperature: proporciona informacion sobre la
temperatura el final de los calculos.

Time to Critical Solid Fraction: proporciona el tiempo que necesita la
aleacion para alcanzar el valor critico de la fraccion solida.

Time to Eutectic Temperature: tiempo que tarda la aleacién en alcanzar
la temperatura eutéctica.

Temperature Gradient at Eutectic Temperature: informa sobre los
gradientes termicos en la aleacién a la temperatura eutéctica.
Temperature Gradient at Solidus — Degrees Celsius: informa sobre los
gradientes térmicos en la aleacién en la fase solida.

Local Cooling Rate: informa sobre la velocidad de enfriamiento
Solidification Time: muestra el tiempo de solidificacion.

En la opcidn Style podemos cambiar la forma de visualizar los resultados de la pieza.
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Capitulo 7: Variaciones del molde

En este capitulo se explican los procesos de llenado y de solidificacion que se
realizan y un posterior analisis de los resultados.

Se realizan diferentes pruebas para ver como se llena, se solidifica y la evolucion
de las temperaturas para evitar que se produzcan defectos en la pieza.

7.1 Primer molde

En la primera simulacion realizamos el llenado de la pieza por medio de un
canal de alimentacion.

Sobraderos

\Bebedero

¥=— Canal de alimentacion

Figura 7.1

Se trata de observar como se llena el molde y como se solidifica.

Se representa el proceso de llenado donde el flujo de metal es representado por
el color rojo, la parte de color gris es la pieza.

Pagina 96 de 107



Figura 7.2

Se observa en llenado de la pieza ya que el flujo de material en la entrada de la
pieza es continuo.

Durante el proceso de solidificacion el metal liquido estd representado por el
color rojo, la pieza es representada por el color gris.

Figura 7.3
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Se puede observar en la solidificacion que lo ultimo que se solidifica se
encuentra en el interior se la pieza. Esto da lugar a la aparicion de rechupes o
distorsiones en el interior de la pieza ya que los sobraderos no pueden aportar el
material para compensar la contraccion del aluminio.

7.1 Segundo molde

En la segunda simulacion realizamos el llenado de la pieza por el bebedero
situado en el eje grande.

Bebedero /

Sobradero

Figura 7.4

En esta simulacién se realiza para observar como se llena la pieza y su evolucién
durante el enfriamiento.

Ahora se analiza el proceso de llenado donde el flujo de metal se representa por
el color rojo, la parte de color gris es la pieza.
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Figura 7.5

Se observa que al comienzo del llenado debido a la colocacion de la entrada la
colada choca con el macho se puede producir salpicaduras lo que puede dar lugar a la
aparicion de gotas frias.

Durante el proceso de solidificacion el metal liquido esta representado por el
color rojo, la pieza es representada por el color gris.
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e
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Figura 7.6

Se puede observar que la solidificacion se produce antes por el eje pequefio
debido a que es la zona mas alejada de la entrada. También se observa que la
solidificacion del material por el bebedero y la mazarota se produce antes que en la
pieza quedando bolsas de liquido en el interior de la pieza. Esto da lugar a la aparicion
de rechupes o distorsiones en el interior de la pieza ya que la mazarota no puede aporta
material para compensar la contraccion del aluminio.

7.1 Tercer molde

En la tercera simulacién realizamos el llenado de la pieza por el bebedero
situado en el eje pequefio.

Sobradero /

\ Bebedero

Figura 7.7

En esta simulacion se observa si se ha producido algun cambio en el llenado o en
la solidificacion.

Se representa el proceso de llenado donde el flujo de metal es representado por
el color rojo, la parte de color gris es la pieza.
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Figura 7.8

Se observa que durante el llenado debido a la colocacién de la entrada, la colada
choca con el macho por lo que se puede producir salpicaduras lo que puede dar lugar a
la aparicién de gotas frias.

Durante el proceso de solidificacion el metal liquido esta representado por el
color rojo, la pieza es representada por el color gris.
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Figura 7.9

En este caso se observa que la solidificacion empieza por el eje grande que igual
que en la simulacién anterior se trata de la zona més alejada de la entrada. Se observa
que la solidificacion del material por el bebedero y el sobradero se produce antes que en
la pieza quedando bolsas de liquido en el interior de la pieza. Esto da lugar a la
aparicion de rechupes o distorsiones en el interior de la pieza ya que la mazarota no
puede aporta material para compensar la contraccion del aluminio.
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7.4 Cuarto molde

En la cuarta simulacion realizamos el llenado de la pieza por medio de un canal
de alimentacion al cual se ha aumentado de tamafio.

Sobradero ———— Bebedero

Canal de alimentacion

Figura 7.10

En esta cuarta simulacion se trata de mejorar la solidificacién aumentando de
tamafio en el canal de alimentacion para evitar una solidificacion prematura de la pieza.

Se representa el proceso de llenado donde el flujo de metal es representado por
el color rojo, la parte de color gris es la pieza.

Pagina 103 de 107



¥ d
L L g

Figura 7.11

Durante el llenado no se aprecia ninguna mejora respecto a la primera
simulacion.

Durante el proceso de solidificacion el metal liquido esta representado por el
color rojo, la pieza es representada por el color gris.
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Figura 7.12
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Se observar una mejoria en la solidificacion del material debido a que no es tan
prematura la solidificacion en el canal de alimentacion pero aun no es suficiente dado
que en la parte central de la pieza aun queda metal liquido. Esto puede dar lugar a la
aparicion de rechupes o distorsiones en el interior de la pieza ya que la mazarota no
puede aporta material para compensar la contraccién del aluminio.
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Conclusiones

Para concluir podemos decir que hemos realizado la simulacion de una pieza, de
modo que nos permite visualizar el proceso de fundicion y analizar los errores en el
disefio. También se han realizado diversos moldes, modificando la forma de llenado,
para analizar las variaciones que producen en los procesos de llenado y de solidificacion,
asi como, si se ha producido alguna mejora en el resultado final de la pieza.

En las hojas anteriores se afiade un guion del programa tanto para el profesor
como para el alumno para la correcta realizacion de la simulacion.

Dejando como futuro trabajo la realizacién de simulaciones en otros tipos de
moldes.
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